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Online Registration

Register here after purchasing StudioLine. You will be notified of updates, receive complimentary web
space and have access to our product support.

http://www.studioline.net/en/support/registration/

How to Reach Us

Visit our discussion forums 24 hours a day to trade your experiences, discuss product related issues
and get answers on the product usage. We usually respond to posts within a business day:

http://talk.studioline.net/

Updates, news and related products can be found on the product web site:

http://www.StudioLine.biz/

Log Files

In the “Help” menu, you can choose the 'Contact H&M's Customer Service' tab. This prepares an
Email that contains the log files created by StudioLine on any given day. These Log files provide the
details of numerous StudioLine internal functioning and steps that when analyzed, can be extremely
helpful in finding the pathway to a solution.

Should StudioLine not work as expected, please choose this menu item to send us an email. Please do
not forget to include a description of the problem as well.
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StudioLine Web Designer 4

StudioLine Web Designer 4 integrates the components for the design, publishing
and maintenance of professional websites into a common user interface – page
editor, image archive, image editing, graphics effects, publishing control, template
editor and site management.

You also can download the online help as a PDF file:
StudioLine Web Designer 4
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System Requirements

Microsoft® Windows® 10 / 8 / 7 / Vista
Processor with a minimum of 1.6 GHz, higher recommended
2 GB RAM, more recommended
150 MB disk space for programs (allow extra space for data)
24 bit graphics adapter with monitor resolution of 1024 x 768 pixels

Supported Languages

English / German / French / Italian / Spanish

Supported Browsers

Recommended browsers for viewing web galleries created with StudioLine:

Internet Explorer, Version 7 and higher
Chrome
Firefox
Opera
Safari

Using MediaCenter in StudioLine requires Internet Explorer Version 7 or higher.

Names of products, services and companies are trademarks of their respective owners.
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Installation Guide

During Setup, StudioLine will adhere to the language settings of the operating system. Once installed,
StudioLine offers a number of supported languages. To choose a language, select “Language” from
the “Preferences” menu. The final system language will be determined when you enter the product
activation code.

Installing from a CD

Insert the StudioLine CD-ROM in the drive to start Setup. If AutoRun has been disabled for your CD-
ROM drive, open “Control Panel” and choose “Add/Remove Programs”.

Installing from the Internet

Download the current version of StudioLine Web Designer from our website.

If prompted, click “Run” or “Save”. If you have saved the installer, double-click the installer file to
start the installation process.

Setup the Data Directory

On first start after the installation, you will be prompted to enter a path where StudioLine stores your
data.

If a Data Directory already exists on your computer (e.g. from an older installation), you can click on
the “Browse” button and select the appropriate path. StudioLine then will use this path and convert
the data to the most current version if necessary.
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Product Activation Code

With the Demo version you'll be able to test all functions of StudioLine for 30 days. You can unlock the
demo restrictions at any time by purchasing an activation code.​ StudioLine will prompt for a product
activation code during the initial startup. The location of the product activation code will differ,
depending on how you purchased StudioLine.

Customers Who Purchased the CD Version

If you purchased StudioLine as a CD, you will find the product activation code printed on a card
located together with the CD inside the case. Do not lose this code; you will need it whenever you
install StudioLine in the future.

Customers Who Downloaded From the Internet

In case you downloaded the software from the internet or purchased the activation code, you will
have received the product activation code per email. Print this email and keep it in a safe place for
future reference. You will need it whenever you install StudioLine in the future.

How Do I Find the Activation Code Inside the Program?

Once you have successfully installed and activated StudioLine, the product activation key will be
found under menu item “About StudioLine” of the menu “Help”.
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Image Archive

1 Menu Bar Access menus divided by commonly used groupings

2 Mode Selector
Switch here between the modes:
Photo: Image Archive
Web: Page Editor, Layout, and Layout Templates
Collage: Print Page Editor

3 Button Toolbar Quick access to commonly used functions, depending of the current mode:
Image Archive, Page Editor, Layout, or Layout Templates

4 Tools Menu Bar Quick access to commonly used functions, depending of the current mode:
Image Archive, Page Editor, Layout, or Layout Templates

5 Bottom Toolbar One-click access to tasks frequently performed

6 Navigation Pane
Mode-dependant: in Image Archive it displays folders of images, in all other
modes it displays the list of websites, web galleries and the folders that
contain them

7 Image Archive or
Page Pane

Mode-dependant: In Image Archive displays all images in a folder in
thumbnail view with descriptors. In other modes it displays the page currently
being worked on.

8 Edit Pane

Via tabs at the top of this multi-use bar, you can navigate to one of three
areas:
Edit: a 'container' for all image tools that have been opened. This area
prevents the tools from blocking your view of the image thumbnails;
Describe: this area allows you to view and input detailed image descriptors
including Exif, location-based, IPTC/NAA and other data
Keywords: an area that allows you to categorize images according to
keywords and classifications.
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9 Resizing Border Click and drag it to change the border between the Navigation or Edit panel
and Image/Page panel.

10 Enlarge Pane
Button Allows you to expand the Image Archive/Page Pane for more workspace

11 Path History A dropdown menu displays the most recently navigated positions

12 Quick Search Allows you to quickly search for images in the Image Archive or text on a
page

13 Recycle Bin Delete images, image tool settings, descriptors, and web galleries

14 Size Selector
Set the display size of thumbnails. For more options with regard to how you
view your Image Archive/Page Pane, go to Display Options under the View
menu bar, or right-click in the Image Archive Pane for the context menu.

The image archive is a key productivity feature of StudioLine. While its use is not mandatory, it
certainly is invaluable for today's media-rich web site projects. Instead of a web master having to
keep track of various derivatives of the same image, StudioLine will centrally maintain picture
originals in its database of images. A folder structure and powerful search engine provide for easy
retrieval and reuse.

Original image corrections, such as cropping, proper alignment and color adjustments need only be
performed once. When an image is placed and customized on a web page, the image archive original
remains intact. Name, descriptions and other information carry over from the archive to any
occurrences on all sites.

Image Archive Directories

The Image Archive is on StudioLine Data Directory on your workstation's hard drive, and includes the
directories “Database”, “Images”, and “Cache”. In the Database directory you find the databank files
and other files that are necessary for Databank administration. Depending on what you selected for
your “Image Archive Copy Preferences”, images are stored in either the Image Directory or externally.
The Cache directory includes the thumbnails in different sizes.

Data Directory Administration

StudioLine Setup installs the program and user files in divided directories. This allows StudioLine to
administer numerous directories. Various directories can be applied after successful installation of the
Set-up program, and call it up, in order to choose another or a new directory. Once the various
directories have been created, you can easily switch between them via the Data Directory
Management window. To get to this, go to the Data Directory Management tab in the Preferences
menu. All of the data directories available are shown in the window. Currently, there is only directory
from which to choose.

If you would like to change the data directory, you will need to select it, press Activate, and ensure
that all currently open StudioLine applications are then closed, before reopening the software.

Inactivated directories can included in the list by using the “attach” button. Likewise, you can delete
directories by utilizing the “detach” button, or you can rename them with “rename”.

If you would like to switch between directories upon opening up StudioLine, be sure to check the box
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“show dialog on start-up”. Directories that are housed on external drives will be shown as unavailable.

Relocation of Data Directories

To move StudioLine from an old PC to a new one, execute the following steps:

Copy the entire StudioLine Data Directory (for example C:\StudioLine - with all the subdirectories)
onto the new PC.

Install the latest version of StudioLine on the new PC. You can download it from our webpage. Provide
the link of the just-copied directory as the new data field. After the installation, activate the software
by typing in your Product Activation Key.

Common Functions

New Folder

Give a name for the new folder. If you have chosen this from the File menu, you will only asked to
provide the new name.

The following options are only available, when you use the New Folder function in the Album pane or
when you right-click on a folder:

If the Open new folder box checked, the newly created folder is opened.
If the Set descriptor defaults for new images is checked, then you can ascribe the images in the
new folder with all of the default descriptors.

Rename Folder

In the Image Archive, to change the name of folders in your Albums, click on the Rename tab under
the File menu. Enter in the new name and click ok in the window that opens up. Alternatively, you can
right-click on the selected object in the left-hand navigation pane and select Rename from the context
menu.

Choose Color

The “Choose Color” window lets you pick up and set any color you want to use for the various
functions, like font color, lonk color, colorize an image, etc.

Old / New
Shows the current active color and the newly selected color.

Note: A rainbow palette indicates that there is not one specific color that applies, for example a
selected text that uses more than one color.

Saturation / Brightness
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The Saturation/Brightness of your color choice is changed by dragging the circular color picker in the
color selection square. Horizontal movement changes saturation, vertical movement brightness.

Hue
The hue changes are achieved by moving the pointed hue pick handle up or down along the rainbow
colored strip.

Red, Green, Blue
Red, Green, Blue indicates the currently active RGB-values. You can enter a specific number to attain
the exact color needed.

Color Box
Color Box stores a color for quick finding later. Simply drag the “Copy” button to one of the empty
color compartments. To use such a stored color simply click on it and it will become the new active
color.

Color Picker
Color Picker is a eyedropper-style color sampler that allows you to pick up a color from any desired
part of your monitor display.

Pick Area
Pick Area allows you to set the size of the color collection area that the Color Picker pipette will
sample. An average RGB-value is calculated.
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Detail View

To toggle to the “Detail View”, click the “Detail” button on the Button Bar. The Image Archive pane
displays all of the images in your selected folder as a thumbnail list on bottom of the Image Archive
pane with a big preview of the selected image above. The thumbnail list can also be moved to either
the left or right side. This optimizes the available desktop space for either landscape or portrait
orientation.

You can navigate through the selected folder my clicking on an image in the thumbnail list. The
“Image Tools” list shows which tools, filters and effects have been used on this image. You can
change the order in which the edits are performed or drag a tool with its settings to another image in
the thumbnail list.

A red rectangle in the thumbnail of the selected image will indicate the current detail area while you
are viewing the image in zoomed mode. To scroll the zoomed image to a different area, either click
the area in the thumbnail or drag the red rectangle to that location.

The optional split view allows you to instantly assess the effect of your edits and image tool settings.
The “before” and “after” images can be displayed side by side or top to bottom. Click the image to
toggle the display between 100% and scaled to fit. This way, you can accurately check the actual
effect of any image edits on true pixels.
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Map View

StudioLine can display images that have been tagged with locations, called Geotagging. You can link
GPS data to images by location or Geotagging in StudioLine. In order to do this, images loaded into
the Image Archive need to have an appropriate GPS log file in the GPX- or NMEA-0183 format. This is
the same file format used by Navigation devices.

To open the Map View, simply click on the “Map” button in the Button Bar. The Image Archive pane
displays all of the images in your selected folder as thumbnails in a left-hand panel, with a Google
map on the right. Images in your folder that are already Geotagged will have a small icon in the
lower-left hand side of the image. The Google map in the right-hand pane will automatically display
the image's position on the map and mark it with a blue arrow.

If you have tagged your image, you can view the position on Google Maps by clicking on the Geotag
button below the image in Image Archive. This will launch the Map View and the image's location will
be displayed in Google maps on the right.

For images that need to be Geotagged, simply type in the name of the location in the menu bar, and
the Google map will automatically position itself there. You can fine tune the location by zooming in
and out on the map and using the cross-hair to specify exactly where the location should be marked.

Once you have found your location on the map, and positioned the cross-hair exactly on the intended
place, then you can use the 'apply position' button to Geotag the image. All the images currently
selected will then acquire that Geodata. The name for this location will be automatically acquired via
the internet (GeoNames). For images that already have GPS coordinates associated with them, but
need the name of the location to be included in the descriptor, simply click on the Retrieve Location

http://www.geonames.org
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Names button. The location names will be acquired and assigned to the image.

In order to view the Geotagged positioning of more than one image at once, click on the Optimize
Scale button and the Google map will be adjusted to include all the locations of your currently
selected photos on one map.

Importing and Exporting a Geotagged Image in .KML

KML is a file format used to display geographic data in an Earth browser such as Google Earth, Google
Maps, and Google Maps for mobile. If you want to upload your geotagged images to Google Maps or
Google Earth, simply select them in the Image Archive, right-click and go to the Geotagging/Create
KML file with thumbnails. A .kml file is then generated that allows you to upload the your image to any
of these commerical programs for viewing online. This is particularly useful if you want to create a
web gallery that indicates the location where the image was created on a map.

You can also import .kml data and images from third parties by going to the Geotagging menu and
selecting Import KML file.

Viewing your Geotagged Image on Google Map/Google Earth

Alternatively, you can select an image and go to Show Image Position in Google Maps under the
Geotagging menu. This will launch your browser and pull up Google maps. There you have a number
of ways in which you can view the position. Either through a typical map, via Satellite (which gives
you an image of the location from satellite) or as a terrain map.

Finally, if you have installed Google Earth, you have the option to look at your image's location via the
Show Image Position in Google Earth tab under the Geotagging menu. If you do not have the program
installed, the menu tab will be grayed out. This program allows you to view the position from a variety
of 3-dimenstional standpoints.

Automatic Tagging

In the Geotagging menu, go to the Import GPS Data for Geotagging and the following window will
open:

Select your files that include the GPS data. Using the beginning and end-time of the GPS-data, all
images that follow these parameters are selected and placed in the Geotagging window. The
difference between GPS-data and the image's date and time of creation is made clear. If the creation-
date is a while in the past, or the images were taken on a foreign trip, you can assess the correct time
via the time difference window. The sign for the time correction can be adjusted. 'Minus' designates a
creation place East of the Prime Meridian, 'plus' indicates West of it. Of course, this is all dependant
on having a properly set clock in the camera.

Choose an image out of the thumbnails for that displays location information, and the relating position
in the window. In the Google map, the image location info is displayed. If this position matches the
actual creation location, you can click on the apply position button to tag the image.
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Timeline View

The Timeline View expands the possibilities of automatically organizing images within a defined time
frame and theme without the need of complex search formulae. To access the Timeline View, click the
“Timeline” button above the album folder tree in the Image Archive.

The top left-hand panel of the Timeline View lists all your folders, the panel below has a drop-down list
where you can choose the type of date by which images are filtered:

Exif Date: This option sorts images by the creation date as recorded by the digital camera. It’s
a snap to find those vacation photos of Maine (when was that again? – 2 or 3 years ago?) plus
you can clearly pinpoint any image to the exact day it was taken.
File Date: This option sorts images based on the day that they were copied to your computer.
This can be helpful for scanned and other images that lack Exif information.
IPTC Date: This option allows you to filter by IPTC Date.
GPS Date: This option allows you to filter by the GPS Date.
Modification Date: This option sorts images based on the date when they were last edited.
This is an excellent way to locate images that you recently have been working on – regardless
of which albums and subfolders they may reside in.
Load Date: This is the date that the image was loaded into the Image Archive. This is also the
view to find the date when a copy or a link was created.

The bottom of the screen has three tabs for time navigation (Year, Month, Day). Here the “Year” tab
opens the one-year calendar overview with highlighted days of all images taken that year in the folder
specified. The monthly calendar view lets you see at a glance which days have images by displaying a
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thumbnail image of the first photo taken that day.

Click on any day and display all those images in the “Day” view. Here, image selection can be made
using the usual methods of right click drag, mouse click, and the “Ctrl” key.

From:
http://help.studioline.net/ - StudioLine Help

Permanent link:
http://help.studioline.net/web/view_timeline

Last update: 2013/06/14 11:12

http://help.studioline.net/
http://help.studioline.net/web/view_timeline


2016/02/08 11:12 17/122 StudioLine Web Designer 4 - English

StudioLine Help - http://help.studioline.net/

Slide Show

Select all images to be included in your slide show and follow this Menu Bar path: “View” → “Slide
Show.”

The slide show opens in full-screen mode and displays the first image. Use your right arrow button on
your keyboard to advance the show. Alternatively you can operate and make changes to your slide
show by right-clicking on the mouse for a context menu once you are in slide show mode. In the
context menu itself are options to navigate forward and backward and make other basic changes to
the Slide Show.

If you would like to operate the slide show from a control bar, click on the Show Control Buttons
and the bar below will appear. You can move it around freely.

Click the VCR-style “Start” button to start the slideshow, or click the “Next Picture” button (right or
left) to display the selected images manually, one at a time.

The rotate as well as the delete buttons are convenient when you are viewing your images for the
first time.

For more advanced settings go to the “Slide Show Settings” window. This is accessed via a button on
the control bar or in the context menu. You can even change settings while the slide show is in
progress. You can specify the time interval between images or change the descriptor text. To add
what text you would like to see, click the button to the right of the “Show Descriptors” field. This
opens the “Text” tool to choose a descriptor and define its on-screen location and presentation.

“Fading Effects” allows you to chose the fade style between your images, and also the fading
duration. You can also choose a Background color and Background music through each of those
respective settings.

The “Content” setting lets you display the selected images only, or allows you to include other images
in that folder and its subfolders. The Order setting allows you to specify the order in which images
appear.

From the Image Archive, the slide show itself can be started by right-clicking on a thumbnail and
selecting Slide Show from the context menu (or “Shift + Z” keyboard shortcut).
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The Page Editor

To edit web galleries, click on “Web” in the Main Tool bar. This opens the most recent opened web
gallery.

At the right of the window you see the “Edit” and “Describe” bar, just like in the Image Archive. In
Page Editor mode, modifications in these panes only take effect on selected objects on the currently
opened page. This way you can change the descriptors or image tool settings for your needs on this
web gallery.

Background

Open the Page menu via the Menu Bar to access the Background options, right-click on the
background portion of a page to access the context menu and choose Background. Either choose a
solid color or drag an image to the Background panel to create a plain image or tiled background.

With the option “Tile Background Image” you can choose between regular tiling, horizonal or vertical
tiling or whether you just prefer a single image as your background.

The background settings cannot be completely deleted. Every page must at least have a background
color. When you drag the copy button from the Background page to the recycle bin, the preferences
of the corresponding layouts from the page editor are carried over. In layout editor, a solid-white
background without an image is placed. (Not sure this works/I understand).
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Solid Color vs. Tiled Background

A solid color background, such as white or dark grey, is frequently the aesthetically most pleasing
choice. It also makes it easy for StudioLine to share images where appropriate.

Irregular textures with little contrast also make a nice background. They should not show any visible
margins when tiled nor interfere with the readability of text.

Busy images, strong contrasts, or geometric patterns may be very distracting. They also introduce a
number of issues when graphics with transparent areas appear on a page.

Transparency and Tiled Background

When transparent images are placed on a page, some of the tiled background will show through.
However, during rendering, a cut-out of the tiled background is incorporated into the graphics file
used by the browser. If for instance, a page is given a centered orientation, the objects move in
relation to the background, when the size of the internet browser is altered. Background images with
geometric or other regular patterns (such as text or logos) may yield less suitable results.

Positioning of Background Relative to an Object

Following are some examples of effects, dimensions, and backgrounds relative to a single object.

Here is a simple 'at' (@) character, created by using the text tool and choosing a font color. The blue
markers indicate the character’s height and width. Because a button effect and a drop shadow were
added, during the creation of the HTML data the text is converted to an image. The @ character and
shadow do not fill the entire solid rectangular area. In some areas, the white background color is
visible. Notice also that because of the drop shadow, the dimensions of the resulting image file are
now larger than the original height and width indicated by the blue markers. Now, as in this example,
when the background is used with a visible pattern, the background becomes visible within the image
as well. During the creation of the HTML dada, StudioLine unites the respective background pattern
with the graphic data, that is prepared for the browser use. As this image is moved for use in other
locations on the page, the grid pattern may not align. Thus it is illustrated that a regular, geometric
pattern (such as squares) can be a poor choice for backgrounds. An exception is when a pages'
content is composed by alignment with the upper lefthand corner.

If, however, regular pattern backgrounds are your preferred design choice, then you should:

use only non-graphical text,
use rectangular images without shadows or soft edges, or
use the Backdrop image tool to place images and text over solid color rectangles, or
place images and text on top of a non-transparent rectangular image.

Page Descriptors

This allows you to create information that can be connected to every page. In the Layout and Page
Editor modes open the window in the Page menu under the Page Descriptors tab. Several of these
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descriptors control how search engines find and index the pages on your website.

Page Title - This is the title that the user's of your website will see in their web browser window and
that will be displayed by search engines. Preset value: PageName

Author - The name of the web page author. Preset value: RegisteredUser

Copyright - Copyright information

Keywords - A list of keywords and sentences that are separated by commas that are displayed on
the page, or have some bearing upon the content of the site. Keywords are used by search engines to
locate your webpages. Keep your list to a maximum of 1000 characters and enter it in lower case.

Description - Description of the page content which will be primarily used by search engines. The
description should be limited to 200 characters.

Parsing by Search Engines - This field allows you to control the kind of information a search engine
robot collects about your site. This field allows you to input META tags and attributes for your page
which will control a robot's behavior. For instance, you may not want your images, error messages, or
any media to be indexed by the robot. Or you do not want any of the links associated with a certain
page indexed. These are the types of meta-tags you can input in this field. Note that many search
engines treat these terms slightly differently.

NOINDEX: Instructs a search engine not include a page in its index (search results).
NOFOLLOW: Instructs a search engine not to follow any of the links in a page.
NOARCHIVE: Instructs a search engine not to provide archived copies of a page to its users.
NOIMAGEINDEX: Instructs a search engine not to index images.
NOMEDIAINDEX: Instructs a robot not index any video or sound media.

Text Preferences

Under the Text tab in the Preferences menu you have options for setting your text. A panel at the top
of the window previews your selections.

Font - You can choose from a list of available fonts.

Text Width - Provides the text width for new text objects.

Size - Choose the size in pixels.

Style - Choose if you would like your text italicized, bold, or underlined.

Ignore font and size of the pasted text - Normally it is possible to paste text from the clip board
of the StudioLine website pages and layouts so that hte font, size and style remains the same.
However, if you have clicked this box in your text preferences, the characteristics of the pasted text
will be ignored. Instead, new text will be adapted to fit the characteristics of text on the page onto
which it is being pasted.
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Guidelines

In Page Editor and Layout mode, you can access, adjust settings, and name guidelines through Guides
under the View tab. In this window you have the opportunity to apply color and set the transparency
factor. Once you have created the parameters for a set of guides, you just need to press the save
button. Another window will pop open that allows you to name the set of guides for use in the future.
All the guide settings you have saved are in the left-hand pane.

Guides enable you to perfectly align various objects along a line. Guides are not design elements;
they will not appear in the output. To create a new guide, click the mouse on the horizontal or vertical
ruler and drag it to the workspace.

You can move your guides at any time by clicking and dragging them. To remove a guide, simply drag
it back to its ruler. Arrange multiple guides on the place to create a general layout pattern for your
page. To space guides evenly or to keep pixel-perfect distances, move the mouse pointer over a
guide. The current position of the guide and its distance to either neighbor will display.

By default, guides act “magnetic”. Objects that you bring near a guide will automatically snap to the
guide's exact position. To change the behavior of guidelines and related settings, right-click on the
page background and choose “Guides” from the context menu.

In the panel “Guides” you can control the “magnetic” property of guides as well as their position and
appearance. With the “Save Settings” button, you can add a pattern of guidelines to the list of stored
settings for future reuse on a similar page.

If you have too many guides and you don’t want to close them one by one, or if they are starting to
become a distraction, you can use the “Clear Guides” button to remove all guides instantly.

Margins

StudioLine utilizes a point exact positioning through which it is possible to place every object on a
page to a predetermined position. The result is that a web browser window doesn't effect the way
your web page or content is displayed.

Through the use of margins a web designer can measure the display of page in relation to the typical
screen sizes. You can use different margins for every StudioLine website.

Go to the Margins tab under the View menu to open up the window.

Show Margins - shows the margins on indicated areas of the computer screen.

Optimize Options - choose the appropriate screen size in pixels. The margins display the
approximate area of a maximized browser window.

Margins on Top - displays the margins in the foreground of the page content.

Note: To adjust the vertical and horizontal page alignment of an opened web page you are working
on, press the Page Alignment buttons in the Tool Bar and choose the appropriate setting from the
drop-down menu.
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Position

This function enables positioning of objects with pixel level accuracy. You access this window by right-
clicking on an object and going to the Position tab.

When a single objects is selected, the positioning number is related to the upper left-hand corner of
the element. When more than one object is selected, the positioning number is also the upper left-
hand corner of the total selection.

Horizontal - move the selected objects either right or left on a page. Increasing the number moves
the object(s) to the left. Decreasing the number moves the objects to the right. Use the arrows just to
the right of the numbers field to specify the exact number of pixels that you would like the object(s)
to be moved.

Vertical - move the selected objects either up or down. The positioning relates to the highest point or
plane of the selected object(s). Use the arrows just to the right of the numbers field to specify the
exact number of pixels that you would like the object(s) to be moved.

Shift Selected Objects - moves the selected object by one pixel in the selected direction. If you hold
down the shift key while you click on the arrow, this moves the selected object by 10 pixels.
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The Text Editor

StudioLine comes complete with a multi-lingual text editor, which integrates smoothly with all popular
word processing programs. In the “Site Settings” panel under the box “Use International (Unicode)
character set (UTF-8 encoding)” and the keyboard layout settings in Windows you can control the
support for international characters sets (such as Greek and Cyrillic).

Text is added by either:

dragging the Text icon from the Tool Bar to a location on the page; or
choosing “New Text Object” from the “Text Processing” item in the Menu Bar, then clicking the
mouse to position it on the page; or
right-clicking on the page and choosing “New Text Object”;
highlighting text in another program or application and then dragging or copying/pasting it to
the StudioLine Page Editor; or
starting another version of StudioLine (found under Menu Bar item “File/New Instance”) and
dragging text from one page to the other.

The default appearance of new text is controlled by “Font Properties” under the Menu Bar item “Text
Processing”. If the “Font Properties” window is not currently open, then the font settings in the “Text
Preferences” window, (accessible via the Menu Bar item “Preferences”) apply. If the “Text Width”
window is currently open (accessible via the Menu Bar item “Text Processing”) then this controls the
initial width for the next text object.

Editing Text

After inserting a new or double-clicking an existing text object, the Text Ruler and the Text Box
become visible. Either can be dragged out of the way, if necessary. Sizing handles to the left and right
of the Text Box are available to change the column width.

Inserting, replacing, deleting, and selecting text is done using standard text processing procedures.
Use the Simple Backdrop Tool from the Image Toolbox to give the text object a background color.

The text editor is closed by clicking elsewhere on the page.

Text Editor Functions

Most text editing functions apply to a specific block of text. Be sure to highlight the text you want to
change, before you choose one of the effects buttons in the Text Editor Bar. The Font Button (bar-like
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button on the left side of the Text Tool Bar) carries on it the name of the currently active font (by
default “Arial”). Clicking on it opens the Font Properties window giving access to font and other text
characteristics. The field “Size” determines the font size of the text in points.

The functions of the other buttons on the Text Tool Bar are as follows:

Color Changes the color of the highlighted text.
Bold Changes the highlighted text to bold.
Italic Changes the highlighted text to italics.

Underline Underlines the highlighted text.
Link Links the highlighted text to a web page or a web address.

Justification Justifies the highlighted text left, right, center, or full.

Bullets

Adds a bullet symbol in front of each marked paragraph to make the text
stand apart. The text attributes for the type of bullet (such as size and color)
are set by hitting the insert key at the end of the paragraph. Choosing “bold”
or “italic” distorts the bullet symbol. The font is determined by the symbol
font.
Note: Bullets can only be used when text is left or fully justified.

Search Searches the highlighted area, the entire Text Box, or all text boxes on a given
page for specified text.

Search and
Replace

Searches for and replaces a specified text in the highlighted area, the entire
Text Box, or all text boxes on a given page.

Spell Checker Spell checks the highlighted text.
Language Assigns a language to the highlighted text for purposes of spell checking.

Paragraph Attributes

Global paragraph text attributes (such as color, bold face, or the look of the paragraph bullet) are
stored in the invisible end-of-paragraph symbol which appears as a blank space behind the last
character of each paragraph. The font of the bullet is always “Symbol” and is never underlined. To
change the text attributes of a paragraph or copy the entire paragraph, be certain to include the
invisible end-of-paragraph symbol in your selection.

Font Properties

In the Layout and Page Editor modes you have the option of specifying the text characteristics. You
access this window by going to the Text Processing menu and clicking on the Font Properties tab.
Alternatively you can reach it under the Text button in the Image Toolbox.

Font - Choose a font from the available list

Size - Choose a font size based on point size

Color - Opens the text color window. You can choose from standard colors or use the color picker to
get an exact match on a color elsewhere on your page.

Alternatively, you can use the hue dial on the right to choose a general color and then the pointer to
get the exact saturation that you are looking for.
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Style - Choose whether you would like the text to be italicized, bold or underlined.

Descriptors

Any titles, captions, and other descriptors that you added to your images can be used to dynamically
generate content in text objects.

First place at least one image with descriptors on your page. Next, open or create a text object. In the
Text Editor, click the “Insert Descriptor” button.

The panel “Insert Descriptor ” offers the available descriptors organized in the familiar groupings.
Choose a descriptor and StudioLine will insert a place holder (for example “Name”) into the text
object. Once you deselect the text object by clicking outside of it, you'll be able to view the
dynamically generated text.

If there is more than one image on a page, you need to associate a text object with a particular
image. Right-click on a deselected text object and choose “Descriptor Association” from the context
menu. Drag the circular association icon from the “Descriptor Association” panel to the image that
holds the descriptors you'd like to use in this text object.

A single text object can contain any number of descriptors, but it can only refer to one specific image.

Search

You can quickly search for text just by entering words into the “Quick Search” edit field of the Menu
bar. After pressing the “Return” key, StudioLine starts to search for the requested text in the currently
opened text editor and then in all other text object on the current page.

Alternatively you can also access them in the respective buttons found in the Text Editor menu bar.
This menu bar is visible when you choose New Text or edit text already on a page. Under the Search
tab, the following window opens up:

Search for - Enter the letters, words, or sentences for what you would like to search on a
webpage.
Search Focus - This is context sensitive depending on where you have clicked before you select
the Search tab. If you are clicked on the page background, you will only have the option of
Search All Text Objects on Page. If you are clicked inside a text object, then you additionally
have the option of Search Current Text Object. If you are clicked inside a text object and you
have a portion of the text selected, you have the above two options and the ability to search
just the Selected Text Object.

As your web page and site increases in the amount of text it encompasses, these options become
more relevant:

Match Whole Word - Click this box if you want results for only the entire word. Otherwise,
StudioLine will find all words that also include the searched word.
Match Case - Click this box if you want only search results that match the case you input.
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Search and Replace

The selections are the same in the this window as for Search (see above) except for the following:

Replace with - Choose the words that you would like to replace the old text with.
Replace - Replaces only the single word just found.
Replace All - Replaces all of the words that fit your search criteria.

Spell Checker

Spelling can be checked using different methods:

Global spell check: Choose “Spell Checker” found under the Menu Bar item “Text Processing”
or directly from the Text Tool Bar.
Check spelling as you type: Questionable words are marked with a wavy underscore. (This
option can be turned off).
Single check: Click right mouse button over a word. If it is not recognized, a list of alternatives
will be offered.

When a questionable word is detected, accept the suggested alternatives, correct the spelling
manually, ignore the word, or add it to a custom dictionary.

Languages

Text can be checked in a variety of languages. To associate a different language to a section of text,
select it and press the Language button on the Text Tool Bar. The default language is determined by
the operating system. Text pasted from a Word Processor retains the source language.
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Layout Templates

To achieve consistent appearance and facilitate easy navigation, web sites typically match designs
across many pages. In StudioLine, Layout Templates and Layouts define common design elements,
such as the background, logos, headlines, navigation buttons, and image placeholders. They also
control certain automated and default behaviors, such as the creation of image views and image
processing defaults.

Layout Templates vs. Layouts

The following chart explains the differences between templates and layouts, in terms of their scope,
when they are used and how they interact.

Effect Layout Template Layout

Scope Affects all new pages of a site, and their image views
(if any).

Affects the single page and its
image views (if any).

Timing
When page is created or when template is manually
applied to an existing page.
If the template is modified, all applied pages will be
updated.

A layout is an integral part of its
page.

Interaction May be defined as the site’s default. May be applied
manually to an existing page.

May be saved as a new Layout
Template.

If common design elements or settings are to be shared by multiple pages, place them in a Layout
Template. If common design elements or settings are to be used by a single page with automatically
created image views, place them in the Layout. If design elements are limited to a single page, place
them directly in the Page Editor.

Applying a Layout Template

When a page is created, the default Layout Template from the Site Settings is always used to initialize
the new page. To apply a different Layout Template:

open the page
open the StudioLine Explorer
choose Layout Templates
locate a suitable template and drag it onto the workspace.

Note: Once a different template has been applied to a page, this step cannot be reversed with the
Undo function. Prior customizations, defaults and image settings for this page and its image view
pages could be lost permanently. To avoid problems, apply the correct template before working on
the page itself.

http://help.studioline.net/web/layout
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The Layout Editor

The Layout and Layout Template modes are an extension of the page editor and offer largely identical
functions. One can think of layouts as the control layer for a page, and layout templates as their
blueprints. To view and customize the layout of a specific page:

open the page in Page Editor mode
switch to Layout mode

To view and customize a layout template:

switch to Layout Template mode
select a template

Transferring Objects to the Layout

From a creative standpoint it is often easier to first design a boilerplate page without deciding
immediately whether some objects belong on the layout. Once the creative process is complete:

open the page in Page Editor mode
from the Edit menu, choose Lock Layout Objects
select any objects that should be located on the layout
right click on the mouse to access the Context menu and choose Transfer to Layout

Note: This is not available for Layout Templates!

Image Views

The “Image View” window allows you to create templates for image display that will appear on your
website page. Using this tool, you can edit and create effects for all of the images on that particular
website page.

The true powers of templates and layouts come to light when you define Image View pages. Layouts
with Image Views will automatically generate interlinked sub-pages with common style elements,
navigation buttons and automatic text generated from image and page descriptors.

Typically, the initial image defined with the Image Prototype for a particular webpage would be
relatively small, like a thumbnail. Once multiple photos are imported from Image Archive onto the
page, the resulting webpage would be composed of a gallery of thumbnails, or whichever size you
chose using the Image Prototype. Then you could create additional Image Views for that webpage
with increasingly larger sizes. The resulting sub-pages display only one picture each, at the size that
you specify using the Image Prototype. A web visitor would simply click on a picture to see a larger
version, or choose a navigation link to browse between Image View pages.

Creating Multiple Image Views
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With the use of the Image Views window, you can create sub-pages for each main page, and assign
individualized effects for the images displayed.

To create sub-pages or additional Image Views for your website page: Open the Layout or Layout
template.

The Image Views window appears on which you can see a mini version of your website page, and a
default sub-page, called Image View 1. If you would like more than one sub-page, press the “New
Image View” button, and an additional page will be created called the Image View 2.

Whenever possible, use placeholders instead of static text. This way, text is automatically substituted
through image, page and system descriptors.
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Collages

Ready-made print projects cannot possibly cover the entire range of creative ideas. Therefore,
StudioLine allows you to design your own print projects as well. With “User Styles”, you can place any
images and text on a blank page, and edit at will.

Select any image you would like to use for your print project, click symbol “New” and choose entry
“Greetings Card, Calendar” to open the “Print Project” window. Choose “User Styles” and “New Page”.
Alternatively, you can click symbol “New” and choose “Collage” to skip the style selection.

After clicking “Continue” you move on to the “Create New Page” window where you type in a name
for your project. Click “OK” to proceed.

Using the “Page Setup” window you define the page format for your project. You can later review and
change those settings by choosing “Page Setup” via the item “File” from the Menu Bar. When
finished, click “OK” to access a blank page in the StudioLine Page Editor.

The white canvas represents the paper format you've chosen.

Print Projects

Print projects include CD jewel case covers and inserts, greetings cards, and calendars. Depending on
the intended project, choose either one or multiple images, then click “Print | Print Project” from the
“File” menu.

On the “Print Project” panel, choose a style from the available categories.
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CD Covers and Inserts

The “CD” category offers templates for a CD index and front and back covers. For the covers select a
single image; for the index you may choose up to 30 images. After choosing a style, enter a name for
your project. Click “Continue” and you will be prompted for additional text required by your project.
Next, StudioLine will compose the print output and display the Page Editor.

The CD index cannot be modified in the Page Editor, but you can change pictures and text for the CD
covers.

Greeting Cards

This category offers greeting card templates in portrait and landscape format. Choose only one image
– if more than one image is selected, then the first one will be used.

After choosing a style, enter a name for your project. Click “Continue” and you will be prompted for
additional text called for by your project. Next, StudioLine will compose the print output and display
the Page Editor, where you can still change the picture and edit the text.

Calendars

This category offers templates for calendar pages and covers. For the cover, choose a single image.
For calendar pages, choose up to 12 images.

After choosing a style, choose the calendar year and starting month. By default, StudioLine will start
with month number 1 – January. Next, enter a name for your project. Click “Continue” and you will be
prompted for additional text required by your project. As you continue, StudioLine will compose the
print output and display the Page Editor.

In the Page Editor, you can still change the picture for calendar pages and the cover. In addition you
may edit the text for calendar covers.

If you are creating multiple calendar pages, then the first page will appear in the Page Editor. The
“StudioLine Explorer – Pages” will also open. Right-click on one calendar page at a time, then choose
“Open” from the context menu to review, edit, and print each calendar page.

Editing

Depending on the style chosen for your project, you may be able to update certain aspects in the
“Page Editor”.

To edit text, click “Edit” in the QuickStep Bar. Each click will offer a different text element for editing.

To replace a picture, open the “StudioLine Explorer – Image Archive and browse for a suitable picture.
Drag the replacement picture from the StudioLine Explorer panel to the old picture in the Page Editor.
The image is automatically replaced.



Last update: 2014/07/18 06:27 ebook http://help.studioline.net/ebook

http://help.studioline.net/ Printed on 2016/02/08 11:12

Printing

Once you are happy with your pages, click “Print” on the QuickStep bar to open the “Standard Print”
panel.

First choose from the available printers, if more than one is connected to your computer. You can click
the “Settings” button to access the printer specific options. Click “Continue” to proceed with printing.

Accessing or Deleting Collages

Your print projects are available for review and printing in the future. To access previously saved
projects, click the “Collage” icon in the toolbar. A list of previously saved collages will appear. Simply
click on a collage in the list in order to open it for editing.

To delete a collage, drag it from the list to the Recycle Bin, or right-click on the collage and choose
“Delete” from the context menu.

Emailing and Exporting Collages

Print projects can be sent by email directly from within StudioLine and can be exported. Simply click
the “Share” button in the tools bar and choose the email or export function.

For email use, StudioLine renders your print project into a graphics file. You control the file
format and size. For more information about email settings, refer to the earlier chapter
“Sending Images via Email”.
For export, StudioLine renders your collage as a high resolution graphics file. You control the file
format and pick a target location on our disks.
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StudioLine Explorer

StudioLine’s own Explorer is a key component of the software that enables many of the easy-to-use
features and advanced capabilities of the software. It functions similar to the familiar Windows
Explorer, providing access to different classes of objects: the files on your computer and local network
as well as StudioLine-internal objects.

Many StudioLine features and tools require the use of the StudioLine Explorer in order to be able to
complete the tasks. For many basic tasks, the StudioLine Explorer will automatically open to allow you
to easily complete the specific job at hand.

The StudioLine Explorer is a fundamental tool that has several iterations. The principal StudioLine
Explorer can be utilized to access the individual StudioLine Explorer functions. To access the principal
StudioLine Explorer from the File menu choose “StudioLine Explorer”. It will display the individualized
Explorers.

Once you open any of the StudioLine Explorers, whether the principal one or any of the individual
ones, an independent window is launched which can stay open while you perform other tasks. It
operates as a floating window from which you can complete specialized tasks, including drag and
drop operations between folders in different windows, no matter what page, site, or other area of the
software you are currently in.

Understanding the StudioLine Explorer window

All of the StudioLine Explorer windows employ three panes. A menu bar across the top with command
buttons. The left-hand pane allows you to navigate, access and manipulate folders, pages, or type of
Explorer windows. The right-hand content pane allows you to view, access and manipulate objects or
files in the current folder.

The main View button on the menu bar is a “T”. You can use it to toggle between different displays.
You can access a more detailed display with the alternative view button. Or an even more detailed
display possible using the following view button.

Regardless of which display view you are in, you can always increase the size of the images in the
right-hand pane but utilizing the slide in the menu bar, or the arrows to the right of it. Where
applicable, dragging an object from the right-hand content pane to the Trash Can will delete it. For a
list of other supported actions, right-click on the mouse over a folder or page to open its context
menu.
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Preferences

The appearance and function of the Image Archive Pane can be customized to suit your personal
preferences. Open the Menu Bar item “Preferences” and choose “Image Archive”. A window titled
“Image Archive” will open. It allows you to control specific aspects for each of the content views, the
color profile, and advanced settings.

Under Albums, you can control the size of and distance between thumbnail images for individual
folders. You can also reach this window by right-clicking on the background of the Image Archive
Desktop and choosing “Display Options” from the context menu.

Proxy Images

This window can be opened under Proxy Images tab in the Preferences menu.

The proxy image is a hard disk space-saving version of the original picture that has a low resolution
and quality. You can make modifications to the settings in the dialog box.
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Keyboard Shortcuts

Workspace and Global Shortcuts

F1 Request context sensitive help on the current object. If no object is
selected, then the Help Table of Contents opens.

Ctrl + S Saves current page.
Ctrl + “+” / “-“ Increases / decreases the image size.

Alt + F4 Exit program.
Tab / Shift + Tab Jumps to next or previous object on the page.

F5 Refreshes the current list in StudioLine Explorer.

Alt + Enter Displays the context menu for the selection. The context menu key on the
Windows Keyboard is also supported.

Delete Deletes the current selection.
Ctrl + A Selects all objects.

Ctrl + Mouse Click Toggles the selection. The object is either added or removed from the
selection.

Shift + Mouse Click Adds the object to the selection.
Right Mouse Click /
Shift + Right Mouse

Click
Opens the context menu for the object selected.

Ctrl + Right Mouse
Click Opens the context menu for the current selection.

Ctrl + C Copies the current selection to the system clipboard (Copy).
Ctrl + X Moves the current selection to the system clipboard (Cut).
Ctrl + V Pastes the content of the system clipboard (Paste).
Ctrl + Z Undo.
Ctrl + Y Redo.
Ctrl + J Joins / splits text objects.
Ctrl + G Toggles the display of object status icons.
Ctrl + L Locks layout objects so they can't be selected or moved accidentally.
Ctrl + P Fixes the object at its current position.
Shift + Z Opens the full screen slide show.
Ctrl + F Opens the search dialog.
Ctrl + I Opens the image toolbox.
Ctrl + T Opens the Histogram.
Ctrl + D Opens the descriptor dialog.
Ctrl + O Create copy and open with the Windows default application.

F7 Create preview.
F8 Start transfer.

Page Up / Page Down
/ Pos1 / End Scroll the workspace up / down one page, scroll to the top / end.

Arrow Keys Moves the current selection in the direction of the arrow by one pixel. Press
and hold the Shift key to move the current selection 10 pixels at a time.
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Shortcuts in the Image Archive
Ctrl + S In the Image Archive, turns on/off the magnifier.

Ctrl + ”+”/”-“ Zooms in/Zooms out.
Ctrl + O Create a copy and open with the default Windows application.

Shift + Ctrl + O Open original with the default Windows application.
Shift + Z Launches the full screen slide show.
Ctrl + F Opens the search dialog in the image archive.

Ctrl + Drag Create a Copy.
Alt + Drag Create a shortcut.

Ctrl + Arrow Left/Right The selected image is rotated counter clockwise / clockwise.

Shortcuts in the Page Editor
Ctrl + S Saves the current page in the page editor.
Ctrl + J Connects or divides the text editor.
Ctrl + H Toggles between selected/deselected.
Ctrl + L Fixes objects, so they can't be chosen or moved.
Ctrl + N Displays or hides the container.
Ctrl + P Fixes the object's position.

F7 Create preview of page/web gallery.
F8 Transfer page/web gallery to a server.

Ctrl + F Opens the dialog “Find and Replace” for text.
Alt + Drag Create a Copy.

Arrow Keys Moves the selected objects in the direction of the arrow by one pixel. Press and hold the
Shift key to move the selected objects 10 pixels at a time.

Shortcuts for Palettes

Esc
When used with a text field: Reverts the text field to the content it had before any
key was pressed and exits the field.
When used in a message box: Equivalent to Cancel button.

Shift + Esc Reverts the text field to the content it had before any key was pressed.
Tab / Shift +

Tab Jumps to the next or previous field.

Shortcuts for Lists
Arrow Up /Down Scroll list by one item.

Page Up / Page Down Scroll a full page.
[keyboard input] Scrolls the list to an item that starts with the input characters.

Enter In a hierarchical list, opens the next hierarchy (if supported).
Backspace In a hierarchical list, opens the previous hierarchy (where appropriate).

Shortcuts for the Text Editor
Del Deletes a character to the right of the cursor.
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Ctrl + Del Deletes a word to the right of the cursor.
Backspace Deletes previous character.

Ctrl + Backspace Deletes a word to the left of the cursor.
Ins Toggles between Insert and Overwrite mode.

Home Beginning of line.
End End of line.

Ctrl + Arrow Up Beginning of paragraph.
Ctrl + Arrow Down Beginning of next paragraph.

Ctrl + Home Beginning of first paragraph.
Ctrl + End End of last paragraph.
Ctrl + Left Beginning of previous word.

Ctrl + Right Beginning of next word.

Shift + Arrow keys Moves the cursor to the appropriate position and selects any text in
between.

Ctrl + B Bold.
Ctrl + I Italics.
Ctrl + U Underlined.

Ctrl + J Splits the current text object into two at the cursor position, or joins
multiple selected text objects into one.

Ctrl + Shift + A Toggle case between three states: lowercase, Title Case, all caps.

Ctrl + Shift + V Pastes the content of the system clipboard without any text formats
(Paste plain text).

Ctrl + Click or Double-
Click

Selects the word the text cursor is on. Drag the mouse on the last click
to select additional words.

Shift + Click Selects text block between position of text cursor and position of
mouse pointer. Drag the mouse to change the text block.

Shift + Ctrl + Click Selects text block starting from the full word at the text cursor position
up to and including the word at the position of the mouse pointer.

Triple-Click Selects entire paragraph. Drag the mouse on the last click to select
additional paragraphs.

From:
http://help.studioline.net/ - StudioLine Help

Permanent link:
http://help.studioline.net/web/keyboard_shortcuts

Last update: 2013/08/26 12:08

http://help.studioline.net/
http://help.studioline.net/web/keyboard_shortcuts


2016/02/08 11:12 39/122 StudioLine Web Designer 4 - English

StudioLine Help - http://help.studioline.net/

Importing Images

To use StudioLine for your images, they need to be added to the StudioLine Image Archive. StudioLine
offers two methods for managing images:

"Copy" Mode

Images from an external source like a camera or CD are copied into the StudioLine Image Archive.
Once copied we refer to them as internal images.

Once StudioLine has created this master-copy in the Image Archive, you could decide to delete the
original image. A practical example would be the memory chip of your digital camera. After importing
photos into StudioLine, the camera’s memory chip could be erased to make room for new pictures.

Digital camera users should always operate in “Copy” mode. Some cameras may reuse the same file
names each time the memory chip is erased, for example DSCF0001.jpg. Next time you copy your
picture files to a Windows folder that already contains prior images from your camera, Windows may
encounter duplicate file names and offer to overwrite the older pictures. This may cause you to
accidentally lose irreplaceable memories. This is never an issue when you import your pictures
directly into StudioLine using the “Copy” mode, since identical file names pose no problem to
StudioLine.

The “Copy” mode is suited for all data storage media because it is the safest. External programs have
no access to the StudioLine data files. Your files can not be accidentally changed or deleted.

"Don’t Copy" Mode

The actual image resides outside of StudioLine’s Image Archive, and only references to these original
images are copied into the Image Archive. We refer to them as external images. Sometimes an
original image is located on removable media or is temporarily unavailable for other reasons,
StudioLine therefore generates a “Proxy Image” much like a thumbnail in the Image Archive. Settings
regarding proxy images are found in the “Preferences” menu.

The “Don’t Copy” mode should only be chosen if you prefer not to delete your original images from
your hard disk and can’t afford the additional disk space for StudioLine to create its master-copies. If
you chose this mode for CDs, DVDs or other removable media, especially your camera, then you may
find it inconvenient to always have to keep these media close at hand. The risk is very high that you
accidentally erase or overwrite images on such media. Again, your digital camera is a good example.
Furthermore, every time you need to create a high-resolution print or want to export the image,
StudioLine would prompt you to insert the disc or connect your camera.

It is generally recommended that you use the “Copy” mode as long as you have available disk space.
Once disk space gets sparse, StudioLine offers the offload feature for older or less frequently used
images.

Your choice of internal vs. external images has no bearing on your ability to manage, edit, and
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process your pictures with StudioLine.

You can decide how StudioLine will
manage your images in accordance
with the different types of media you
choose. Select “Image Archive Copy
Settings” from the Menu Bar
“Preferences”. (The “Image Archive
Copy Settings” window will open
automatically the first time you load
images).

In addition to setting “Copy” and “Don’t Copy” modes, you can also choose to be prompted during
each import simply by selecting the setting “Ask”. This is a good choice if you want to be able to copy
images from borrowed CDs, but not copy images from any CDs that you own.

You may change your settings at any time. Of course, this would only effect any new images still to be
added to the Image Archive. Existing images stored internally may be converted to external images at
any time, as well as external images to internal ones, as long as you still have access to your
originals.

Internally- and Externally-Stored Images

To convert internally-stored images to externally-stored ones, or vice versa, select the images and
click on one of the images with the right mouse button. Choose “Original” from the context menu and
then the option “Store Externally” or “Store Internally”.

To move an image to external storage, you will need to select a target folder.

To import an image to internal storage, you may be asked to insert the appropriate CD, DVD or other
removal media, if that’s where the original picture resides.

Importing Images Using the Load Assistant

Using the StudioLine Load Assistant saves much time and effort, because you decide before the
transfer begins which images, images with sound annotations, and movie files you actually wish to
load into your archive.
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When starting StudioLine, the Load Assistant automatically recognizes all files located in the “DCIM”
folder of an external drive (for example your camera’s memory card) the moment you connect it to
your computer.

In the image preview, all found images are displayed as thumbnail images enabling you to easily
recognize your files. Movies and sound files are presented with an icon. Using this overview, select
the files which you would like to import into StudioLine by using the following easy means:

Upon opening the Load Assistant, all files are automatically checked off for loading. To remove
individual files not wanted, simply uncheck them.

To uncheck or recheck all files, click with your right mouse button in the image preview area and
choose the appropriate command from the context menu.

You could also use the keyboard combination “Ctrl+A” to select all files, then checking off one of the
boxes under a thumbnail to set the checks for all.

Using your mouse you could alternatively drag and select a grouping of files. Clicking on individual
files while holding down the “Ctrl” key allows you to add or delete from the grouping. Once you have
made your total selection, right-click into the selection and choose “Check Selected” or as the case
may be, “Uncheck Selected.”
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On the right side of the assistant panel set the destination for the loaded images. Using “Search” you
can pick an existing folder inside the archive. You may wish to create a subfolder and have the files
loaded into it.

It is possible to rename the images while loading – if you wish, in consecutively numbered order. This
way your images have a meaningful name right from the start, while preventing future work in the
process.

Older Windows versions only allow the Load Assistant to be summoned up manually. There are two
ways to do this:

Follow the menu path: “File” → “Import” → “Load Assistant.”

Open the StudioLine Explorer under File in the Menu Bar and click, without having selected a file, on
the “Load Image” icon.

Reload Source Image

If you are in the Image Archive you can go to the Image menu and the Reload Source Image tab. This
option allows you to reload the graphic data that was originally imported into StudioLine. If available,
StudioLine searches for the data in its original position. If the files can't be found and only one image
is selected, the user is prompted to search for the files in the StudioLine Explorer - Image Archive.

This function can improve the image quality after a small piece of the image has been first cut and
then increased in size. Through the subsequent download function the original graphic files are
restored and the cut out area is saved in the highest resolution as defined by the Image Rendering
settings, found under the Preferences menu. If you are working with Kodak Photo-CD the best suited
resolution is uploaded.
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RAW Images

There is no common “file format” for RAW images. Different manufacturers and camera models have
different formats. StudioLine can import RAW images from all popular “RAW capable” camera models.

A special object status icon ( ) is used to identify RAW images after import.

If StudioLine can determine the camera model used to capture the RAW image, then it will
automatically choose the applicable processing. If the default processing does not yield optimal
results, click the RAW object status icon to control the processing in detail.

Use the “RAW Settings” panel to fine-tune StudioLine’s pre-processing to suit your taste. Any change
in the settings requires that StudioLine has to process a potentially large amount of raw image data to
render a new image. It may take a little while, before the new image becomes visible in the Image
Archive. Images with customized RAW pre-processing appear with a different object status icon: 

Once you have found optimal RAW processing settings that are ideal for your camera, click the “Use
as Defaults” button. Your settings will be copied to the “RAW Default Settings” in the “Preferences”
menu.

RAW-based images can be further enhanced using any other StudioLine tools and filters, as with any
other image type.

http://www.studioline.net/en/support/raw-support/
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Duplicates and Shortcuts

There may be occasions when you would like to have more than one copy of the same image to work
with. StudioLine addresses this situation with two functions.

Creating Image Duplicates

To duplicate a picture, click with the right mouse button on the image and choose “Create a
Duplicate” from the context menu. The resulting duplicate is an entirely new image; you may edit this
duplicate and add unique descriptor texts free from associations to the source image.

This feature is helpful if you want to keep separate copies of different detail views or cut-out areas for
one and the same picture, or to compare the effect of different combinations of filters and settings
against the same image.

Creating Image Shortcuts

To create an image shortcut, click with the right mouse button on an image and choose “Create
Shortcut” from the context menu. Image shortcuts are recognized by the arrow icon in the bottom left
corner of the thumbnail (see below).

An image shortcut is not a separate image, but simply a placeholder object that refers back to the
original. Any editing or changes against an image shortcut will actually be applied against the original.
Editing and changes that are applied against the original will be reflected by all its shortcuts, if any.
Deleting the original image will also remove all its shortcuts from the Image Archive.

This feature is helpful if you want the same image with identical descriptions, tool and filter settings
to appear in more than one folder, for example folder: “Summer Vacation” and folder: “Animals”.
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Descriptors

Descriptors are used to store your descriptive information in different categories. Descriptors can be
printed below their images, included in emails, or added to web galleries. They also help the search
engine in grouping images that match a common theme. Additionally, they can be used for sorting.

Once you load an image into the Image Archive the descriptors “Image Name”, “Description”, and
“File Date and Time” will display below the thumbnail, some will already filled in with information from
your camera.

“Image Name” defaults to the file name of the imported picture. The same information is also stored
in the descriptor “File Name”. Often, the file name is automatically generated by digital cameras or
scanners is rather cryptic (for example “DCF0033”), which makes it entirely unsuitable as an image
title in web galleries, emails, or prints. Therefore, you should immediately give each picture a
meaningful image name. You may even give similar images the same name – there is no need to add
numbers in sequence. The descriptor “Description” is left empty, inviting you to enter your own text.
The “File Date and Time” are carried over from the creation date of the original file.

StudioLine Descriptor Types

All Descriptors

This category displays the complete set of descriptors, organized by the groups to which they belong.

To copy a descriptor to other images, click and hold the mouse button on the “Copy” button, then
drag it to other images. Alternatively, you can first press the “Ctrl” key while selecting a number of
images. Then click the “Copy” button to copy the descriptor to all selected images.

You can also left-click on the descriptor directly underneath the image to highlight it, and then right-
click to get a context menu with additional options. Once the descriptor is highlighted in the image
archive pane, you can also delete it by dragging it to the recycle bin.

A grey “Copy” button indicates that all selected images already have the same descriptor content. A
blue “Copy” button indicates that all or some images do not yet have matching content.

If the button is not checkered, this means the descriptor cannot be copied.

User Descriptors

This is the category where you can create your own descriptor tags, such as “Event” or “Holiday”, and
then fill-in your content. This will improve the success rate of locating your images later.

You can delete obsolete descriptor tags, which will also delete their content.
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System Descriptors

Some of these descriptors were created during loading. Some will have default values and others you
can also input your own information as desired.

Camera Descriptors (Exif)

Cameras will record various properties with each image, for example: camera model, exposure, f-stop
value, etc. These properties are also known as “Exif” or “Exchangeable Image File format”.

Most of the Exif content cannot be modified and appears in dark grey.

IPTC/NAA Descriptors

These are descriptors following the standards of the International Press Telecommunication Council
and the Newspaper Association of America.

For these descriptors you can supply or revise the content. If images are exported to JPEG file format,
they will include the IPTC/NAA descriptors and are available for use in other applications.

Windows Descriptors

These Descriptors can be accessed via Windows Explorer. In StudioLine, you can supply or revise the
content of these descriptors. If images are exported to JPEG file format, Windows descriptors are
included for use in other applications.

Forms

For the quick application of frequently-used descriptors of your own choosing, you can create a Form.
To create your personalized form, click the “Create Form” button in the button bar of the Descriptors
window.

Type in a name for your form and click “OK”. The new name will appear in the Form list.

The window “Edit Form“ opens. By selecting descriptors in the left panel and clicking the right-arrow
button in the center, you can put together a customized list of descriptors.

You can always edit your Form by clicking on the “Edit Form” button located in the button bar of the
Descriptors window. To remove a descriptor from your list, select it and use the left-arrow button.



Last update: 2014/07/18 06:27 ebook http://help.studioline.net/ebook

http://help.studioline.net/ Printed on 2016/02/08 11:12

From:
http://help.studioline.net/ - StudioLine Help

Permanent link:
http://help.studioline.net/web/descriptors

Last update: 2013/06/13 09:49

http://help.studioline.net/
http://help.studioline.net/web/descriptors


2016/02/08 11:12 49/122 StudioLine Web Designer 4 - English

StudioLine Help - http://help.studioline.net/

Editing Descriptor Content

To add or edit text, simply click on the specific Descriptor Line below the image and a space will open
where you can type your text. If the Descriptor Line area is next to the “Date and Time,” right click on
it (or on any of the Descriptor Lines) and a window “Descriptors” will open. Alternatively, you can right
click on the thumbnail picture and choose “Descriptors” from the context menu to open the
Descriptors window.

The Descriptors Panel maintains the text information and other tags associated with an image. At the
top of the window are two arrows which are navigation buttons (see below) to browse to the next or
previous image’s descriptor content. On the Image Archive Desktop, the current image associated
with the Descriptors Panel will be highlighted by a dotted border. As you scroll using the navigation
buttons in the Descriptors Panel, you can see the image highlight border advancing to the next image
on the Image Archive Desktop.

If only one image was selected, then the navigation buttons will automatically select the previous or
next image in the current folder. If more than one image was selected, then the navigation buttons
will browse to the previous or next image of the selection. The image descriptors are organized into
two categories System Groups and Forms, which can be collapsed or expanded by using the ( )
buttons in front of each category. Clicking on these group and sub-group titles lists their content in
the lower panel for you to work with.

Spell Checking

Descriptor text can also be spell-checked. For details go to the Working with Text – Spell Checking
section. However, a quick method is to access the Descriptor Spell-Checker is to right-click on the
descriptor field underneath the image in the Image Archive pane and choose one of Spell-Checker
Options from the context menu.

Setting Date and Time

There are a number of scenarios in which the time stamp recorded by the camera or provided by
IPTC/NAA descriptors may not be correct.

You can correct the information for “Creation Date”, “Date (Modified)”, and the “Date (Original)” by
choosing Edit Date and Time from the Edit menu.

To update more than one image, select them beforehand. Then select the “Edit Date and Time” from
the Edit menu. A prompt will ask you whether you want to edit all the images selected to the same
setting.

The option “Edit Date/Time” is ideal for updating a single image. However, if more than one picture is
selected, all would be set to the exact same time.

The option “Adjust Date/Time” is ideal for updating a series of images and notating the individual time
each image was taken using incremental adjustments. Using this feature is helpful if you want to
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correct time-zone or daylight savings time without sacrificing individual photo time differences.

Setting Geographical Data

StudioLine supports GPS information stored by some camera models. To set or correct the
geographical position of an image, you can double-click on the descriptor content of “Latitude” or
“Longitude” (e.g. in the form “Geographical Data”).

This dialog has the option to enter the position in degrees, minutes and seconds, or in degrees with
decimals.

Alternatively you can open the Map View to set the position.

Automatic Sequencing

To add a sequence number to a description, right-click the appropriate descriptor either under image
or in the descriptor panel and choose “Insert Sequence Number” from the context menu.

The panel “Sequence Number” offers several formatting options and a text preview at the bottom of
the panel. If you would like to use your sequence number for sorting purposes, make sure to choose a
number format with leading zeroes.
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Pre-Defining Descriptors in Folders

StudioLine makes it possible to assign descriptor defaults to folders in the Image Archive folder and
subfolders. In this way, any images loaded into folders with predefinitions will receive those
descriptors automatically. One example of the use of this feature is to ensure that every time you
load an image, the copyright information is automatically added. This will save you a lot of time by
not having to individually assign the copyright afterwards.

Open StudioLine Image Archive and select the “Albums” view. Right-click on the desired folder in the
Navigation Pane for the context menu. Choose “Set Descriptor Defaults” to open the Descriptor
Defaults Window for that folder.

Enter in any desired default descriptors for the folder. This window works exactly the way it does with
images.

Remember that the descriptors you define here should be fitting for all the images that will be input
into the folder.

The descriptors added into this window will only apply to the folder and/or subfolders you selected.
Every time you load new images into that folder, that set of descriptors will be applied.

Alternatively you can access it via the “Descriptors Defaults for Current Folder” button in the
Descriptors panel, or under the “Edit” menu.

Important Note: Should an image you are loading to a folder with predefinitions already contain a
descriptor in a particular field (for example, if the IPTC-descriptor “copyright” is filled in), the original
descriptor will not be overwritten. Furthermore, images already residing in the Image Archive which
you simply move from one folder into another with default descriptors will maintain their original
descriptors and not be updated to match the predefinitions of the new folder. This must be done
manually if you would like them all to match.
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Prefilled Forms

Prefilled Forms allow you to save frequently needed content for image descriptors. You can apply a
single descriptor with prefilled content by dragging it to any descriptor in the Descriptors panel, or
you can apply the content of all descriptors in a prefilled form. You can access it via the “Prefilled
Forms” button in the Descriptors panel.

In order to create a prefilled form, click the button “Create Form” in the Prefilled Forms toolbar, then
enter a form name.

In the panel “Edit Form”, choose descriptors for the form from the list on the left side of the panel.
Double-click an item in the left list, or click on the arrow pointing to the right, to add a descriptor to
the form. Double-click an item in the list on the right to remove a descriptor from the form.

After clicking “OK”, you will be prompted to define the copy rules for the form. There you choose how
to deal with image descriptors that already have content - preserve the prior content of image
descriptors that are not empty, or replace prior content with the prefilled values from the form.

The selected descriptor fields are visible in the lower (or right) area of the dialog “Prefilled Forms”.
There you can enter the prefilled content for the descriptors contained in this form.

Click the button in front of the form name to apply the prefilled content of the form to all selected
images. This will adhere to the “Copy Rules” for the form, either copying the prefilled content to
empty image descriptors only, or replacing existing content.

Right-click the form name to change the list of descriptors for the form, or to change the copy rules.
You can also add new descriptors to the form simply by dragging them from Descriptors panel.
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Image Titles

The display of information below each thumbnail picture can be personalized by you. To add or
remove descriptors, or to change their order, right-click on the background of the Image Archive
Desktop. Choose “Image Titles” from the context menu.

The left half of the window displays the six categories of descriptors and their content. The right half
shows the descriptors that presently appear under the thumbnail picture.

To include an additional descriptor for display, select the descriptor name on the left and click the
right arrow button to move that descriptor into the list on the right side. To exclude a descriptor from
being displayed, click the descriptor name on the right side and click the left arrow to remove it. To
change the order of appearance, click a descriptor in the right panel and use the buttons “Move
Description Up/Down by One” moving the descriptor into the desired position.

To remove the display of descriptors entirely from the Image Archive Desktop (or to enable it) simply
right click on the background of the workspace and uncheck/check the menu item “Show Image
Titles”. Alternatively you could use the keyboard combination Ctrl-H.
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Sorting According to Descriptors

To quickly sort the content of a folder by descriptors, click the “Sort” button on the toolbar or go to
“Sort” in the “View” menu.

The menu allows you to sort by the most common criteria. For each criterion you can choose
ascending or descending alphanumerical order. To sort by other or more complex criteria, choose
“Sort by Descriptors” from the menu available under Sort button. The following window opens up:

The left side lists available descriptors and the right side shows the descriptors currently in use for
sorting the images in their particular folder. Use the arrow buttons to move descriptors back and
forth.

The order of descriptors in the right half of the panel controls multi-level sorting with the top
descriptor having highest priority. For example you could list “Date (Original)” at the top and below it
“Image Name”. The resultant search would order the thumbnails by the date they were created. If
multiple images have the same creation time, they would appear in alphabetical order by Image
Name. Additionally you can choose between ascending or descending order. Sorting by date in
descending order will display the most recent images first.

You can quickly sort an entire folder or sub-folder by right-clicking on the desired destination in the
Navigation pane and selecting “Sort By/Descriptors” in the context menu.
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Keywords

Keywords are used to quickly categorize images. You can easily distribute a simple attribute like
“Flowers” by dragging it with your mouse to the desired image or images. Or you can also display
your images sorted according to such keywords.

In the “Keywords” window, images can quickly be assigned keywords or ratings, then organized by
those classifications or marked for specific uses. The top panel inside this window displays all
currently existing ratings, markers, categories, and keywords. Here you can create new groups or
keywords, manage, or delete them. The lower panel displays only those keywords associated with a
particular selected image or group of images. The content of this panel thus changes accordingly with
the image(s) selected. Utilizing this feature makes it effortless to pick out all images that have similar
attributes.

To access the Keywords bar, open the Image Archive to a particular album or subfolder and click on
the “Keywords” tab on the right edge of the screen. Alternatively you get there via the keyboard
shortcut Ctrl+K. The Keywords pane opens along the right edge of the screen, just like the descriptors
pane.

Assigning and Creating Keywords

Clicking on the “New Keyword” button in the Keywords window toolbar, or by right clicking on the title
of any subgroup in the Keywords panel, opens a context menu. Select “New Keyword” and enter the
name for the keyword. If you want to create more than one keyword, use one line per keyword.
Keyword labels are not strictly limited to single words. However, phrases or terms of more than a few
words should be entered as descriptions, not keywords. Your newly-created keyword will be listed in
the Categories panel under heading “Keywords”.
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To assign a keyword, simply drag it to a desired image or a group of selected images in the work
space using your mouse. Alternatively you could drag the images to the keyword. Any keywords you
assign will be appended to the descriptor system group IPTC by default. This allows you to review all
keywords that have been assigned to an image in one place.

You can, however, associate keywords with any other descriptor system group you desire –
exclusively or with the option of sending a copy of the keyword to the IPTC group as well. Right-click
on the keyword and choose “Set Target Descriptor” from the context menu. Checking off the box
“Insert keyword into following descriptor” enables the descriptors field to be activated. Clicking inside
will open a drop-down selection menu. Pick a suitable descriptor field that the current keyword would
be added to. Checking off the box labeled “Copy to IPTC/NAA Descriptor ‘Keywords’” will send a copy
of the keyword to that group as well.

Alternatively, you can add a keyword to a specific descriptor by dragging the keyword from the
Keywords window to the descriptor of choice in the Descriptors window.

When a keyword is first used, an icon of the initial image will be used to visually represent the
keyword in the Keywords window. To change this icon image, right click on it and select “Remove
Icon.” Then simply drag the keyword to a different image in the Image Archive Pane, or, vice versa,
drag a different image to the keyword.
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Images with keywords are displayed with this object status icon:

Organizing Keywords

Keywords can be grouped into hierarchical lists – equivalent to folders and subfolders. A new keyword
group is created with the “New Group” button.

To open or close a keyword group, click it with the mouse. To move keywords to a group, drag the
keyword(s) to the icon for the desired group. To rearrange the order of keywords in a group, simply
drag them to their new position.

If you have an extensive list of keywords it may be advantageous to switch to smaller icons. Click the
button “Switch View” to toggle displays.

There are a number of keyword sorting criteria when you right-click on the keyword itself and a
context menu opens up. You can create new groups or keywords and apply the key words as desired.

View Images by Keyword

To view all images associated with a keyword, check the box in front of the keyword. On the upper
left side of the Keywords window, click on the “Display” button (or press the “F5” key). This will
refresh the workspace and show all images that were assigned this keyword, regardless of which
albums or subfolders they normally reside in. You can restrict the search to a particular folder by
utilizing the field with drop-down menu next to the “Display” button.

To include images with other keywords, click the checkboxes of those additional keywords. Now,
images that were assigned any of the selected keywords will be displayed together (“OR” condition).
To display the intersection of only those images that were assigned all of the selected keywords
(“AND” condition), click the “All Keywords” radio button in the drop-down menu. Check “At least one
keyword” to undo this view.

Note: Holding down the Shift Key on your keyboard while activating or deactivating a keyword will
instantly refresh the view.

Un-Assigning Keywords

To remove a keyword from an image, right click the keyword in the Applied Keywords panel of the
Keywords window and choose “Remove Keyword” from the context menu. Or right click the image
itself and via the item “Descriptors” in the context menu, choose the keyword that is to be un-
assigned. Here you can alternatively drag the keyword from the keyword list to the recycle bin.

To remove a keyword from all images, click the check-box in front of the keyword to locate all images
that were assigned that particular keyword. Then click the “Select All” icon on the toolbar (or press
“Ctrl+A”) and right click the keyword in the Applied Keywords panel of the Keywords window and
choose “Remove Keyword” from the context menu.
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Deleting Keywords

To delete a keyword from the keyword list, click the keyword, and then click the “Delete Keyword”
button.

Note: Deleting a keyword will automatically remove the keyword from the IPTC descriptor keywords
or any alternate target descriptor in the images.

Changing Keywords

To change a keyword (for example “Holidays” to “Vacations”), click the keyword with the right mouse
button and choose “Rename Keyword” from the context menu. Type a new label over the old one.

Note: On renaming a keyword you will be asked if the IPTC descriptor keywords or any alternate
target descriptor in the images should be updated automatically.

Exporting Keywords

You may want to pass an extensive keyword or category list on to other users or use it in other
applications. StudioLine can export keywords and categories in XML format, and import either XML or
plain-text format (.txt).

To export or import a list, in the Keywords view right click the “Keywords” or “Categories” icons.
Choose “Import” or “Export” from the context menu. If you right-click any of the icons below
“Keywords” or “Categories”, then your action will be limited to that particular sub-classification.
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Ratings

In Keywords view you can rate images on a scale from 1 to 5 stars.

Click on the “Ratings” group to view the five available ratings. Then click on a desired rating and drag
it onto a picture, or drag the picture to the rating. To assign the same rating to multiple images,
select the images in the workspace, then drag the rating to any one of the selected images or the
images to the rating. The current rating for an image can be viewed in the System Descriptor
“Rating”, or by looking at the ratings icon directly under each image (next to the object status icon).
You may also sort images by their rating.

Rather than switching to Keywords view, you can also manage ratings directly in album view. Select
the desired images, then click the “Ratings” button on bottom of the Image Archive.

Rated images will display one of the following object status icons below them.

Click the rating icon to change or remove the rating for the image.

Alternatively, to remove a rating from an image, click the image and drag the rating from the rating
group in classification view to the recycle bin. You may also right-click on the rating and choose
“Remove Rating” from the context menu.
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Marking Images Across Folders

Another great feature of StudioLine is your ability to mark images for a range of tasks at a future
time. You can temporarily mark images from many folders for a common tasks like Email, Export,
Print, Web gallery and Write CD/DVD. You can also mark an image for Lightbox but it gets treated
slightly differently. You can also create, set or delete markers via the Marker menu activated via the
button in the Bottom Bar.

First select the image or set of images you want to apply with a standardized marker. Then go to the
Marker menu and mark the image with the appropriate task. Then, after selecting your image, simply
drag one of the standard markers to the image.

If you create your own marker category, it will become available under the Marker button in the main
toolbar as well, and will allow you to apply all the options to a marked image as with other categories
of standard markers.

Images that have been tagged with a Marker display the icon below them in the Image Archive Pane.
If you roll over the marker icon, it will tell you for which tasks it has been marked. Left-click this icon
to highlight it, and then right-click to have the option to remove it. You will be prompted by a window.

Note: be sure to highlight the text describing the marker ie “Marked for Print” before you right-click
or a different context menu will become available.

Marking Images to Perform a Task

Once you marked an image or several images for a particular standard task, you can go to the Marked
menu via the button below to either view all your marked images in any particular category, or to
perform the tasks for which they are marked.

Once you have selected the task to be performed, email for instance, StudioLine will prompt you to
ensure that this is the task and correct number of images, to which you would like the task
performed. StudioLine alerts you to any discrepancies between images marked and current selection.

Alternatively, you can use the Marked For section of the Keyword Bar to view and select images based
on their standardized marking.

Once the images have been marked, you can also right-click for the context menu to perform the
tasks. After using the marked images for the selected task, you will be prompted to remove the
markers or to retain them. The steps described above are applicable to images marked for printing,
web gallery use, or CD/DVD export. However, LightBox has a unique set of steps. Please see below.

Marking Images for the Lightbox

The purpose of the Lightbox is to mark images located in different folders and compare them side-by-
side for ease of visibility. For that reason, Lightbox thumbnail displays are by default larger as
compared to regular folders. To view all images in the Lightbox, click the check-box in front of the
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Lightbox marker in the Keyword Bar. You can also use the Marker menu to select and view the images
destined for Lightbox viewing.

If you would like to adjust the default size of the Lightbox thumbnail, in the Image Archive go to
Preferences/Image Archive. When the Image Archive window opens, click on Keyword Bar and change
to the desired “Maximum Preview Dimensions for Lightbox”.
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Image Editing

Before you can work with images, they need to be imported into the StudioLine Image Archive. The
image toolbox can be accessed via the Menu Bar item “Image”, or via the Tool Bar button: “Image
Tools”.

In StudioLine, you edit your pictures by applying image tools to them. Each image tool performs a
specific effect to a picture. For instance, there are tools to rotate and crop, adjust color tones, correct
red-eye problems, as well as various special effect filters.

For each image, StudioLine will only save the tool settings you chose and apply them before an image
is displayed or otherwise used. The master copy in the Image Archive remains unchanged. This way,
you can experiment with image tools change settings or reverse any actions – even months later.

Applying an Image Tool

Image Tools are grouped by the following three functions:

Preprocessing: These tools perform initial corrections such rotate, crop, and red-eye
correction, all of which should occur before optimizing colors, exposure, and other aspects.
Correction: These tools are used to optimize your images, for example, by correcting blurring,
improving exposure, and addressing color shifts.
Effects: The fun filters: let your creativity run wild!

To apply an image tool to a picture in the Image Archive, select one or more with a mouse click, then
choose an image tool which opens automatically in the Edit Bar. As you select more image tools, they
too will be added to the Edit Bar. If room for all image tools becomes scarce, click on the minimize
button in an Image Tool Title bar to minimize it. You can also undock an image tool by clicking the
undocking button. Click the same button to re-dock the tool to the image tools pane.

Each Image Tool has its own panel with the settings for the selected tool. Use the various controls to
achieve the desired results. StudioLine will instantly update the picture to show the effect. There is no
need to confirm your actions with an “OK” button. All tools and settings can easily be changed or
reversed at any time.

A tool can be applied to multiple images at once by selecting these images before accessing any tools
or changing settings.

Image Preprocessing Tools

One of the key features of StudioLine is the ability to apply a complete set of image optimizations to
an entire series of similar pictures. For proper image alignments, to crop unwanted borders, or to
correct unappealing red pupil discolorations in people or animals (Red Eye Removal), use the
appropriate tool from the “Preprocessing” section of the “Image Tools” panel.

Since pre-processing tools are specific to each picture and would not be copied to other images, they
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are omitted from the “Active Image Tools List”.

You have quick access to preprocessing tools like “Rotate”, “Crop” and “Red Eye Removal” from the
Bottom Bar.

Active Image Tools List

StudioLine collects all tools, filters, and their settings in a stack (the “Active Image Tools” list), which
is stored along with the unchanged original in the Image Archive. To view the active image tools list,
select an image and right click on the Active Tools Object Icon below it. This will open up the window
displaying the applied tools. Alternatively you could follow this Menu Bar path: “Image” → “Active
Image Tools.” You can also right-click on an image and choose “Active Image Tools” from its context
menu.

Changing the Processing Order

You can control the order in which tools are applied against an image by moving them around within
the Active Image Tools list. StudioLine will apply the tools top to bottom.

To illustrate the effect of different processing orders, select an image, apply the “Black & White” tool,
then the “Colorize” tool to achieve a sepia effect. This will give the picture an aged appearance. If you
reverse the sequence of the filters, then the “Black & White” filter cancels out the “Colorize” tool.

Discarding Tool Settings

To discard the effect of an image tool, simply drag the tool icon from the “Active Image Tools” list of a
particular image into the Recycle Bin in the upper right corner of the StudioLine window. You can also
right-click on any tool icon in the list and choose “Delete” from the context menu. Alternatively, if the
tool’s settings panel is currently open, you can select the particular image and drag the “Copy”
button from the top left corner of the tool’s settings panel to the Recycle Bin.

Copying Settings

There are a number of ways to copy tool settings from one image to another.

Dragging the “Copy” Button to a Single Image1.
Click on the image containing the correct image tools settings. Open the image tool you wish to
copy. Drag the “Copy” button of the image tool’s settings panel to any other image that should
inherit the identical settings.
Clicking the Copy Button2.
Click on the image containing the correct image tools settings. Open the image tool you wish to
copy. Hold down the “Ctrl” key to select additional images (be certain that the original image
remains selected). Click the “Copy” button of that image tool’s settings panel to apply the same
settings to all selected images.
Using the Active Image Tools List3.
To copy the settings of a single image tool, drag that particular tool from the Active Image Tools
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list to any target images. (Right-clicking on the Active Image Tools Status Icon below the image
will open the Active Image Tools window.) To copy all image tools, drag “Copy” button of the
Active Image Tools list onto any target images (or use the “Ctrl” key to select additional images
and then click the “Copy” button).

The “Lock” button (see below) assists in copying tools and settings to images in other folders.

Normally, the Tool panel will display the settings in effect for the currently selected image. If multiple
pictures are selected, the panel will display the settings for the image that was selected first. Clicking
the “Lock” button will turn the button red, indicating that the settings are locked. You are now free to
browse through folders and select different images – the settings will remain “frozen” on the originally
selected picture. When you have located and selected the target image(s), click the “Copy” button in
the settings panel to transfer the tool settings to them.

Histogram

The histogram displays the distribution of pixels based on brightness and frequency in your image.
The x-axis (horizontal) represents brightness ranging from black (0) to white (255). The y-axis
(vertical) represents the frequency of pixels for each particular brightness.

Ideally, an image should display an even balance of dark, mid-range, and bright pixels. Images with
an excessive number of bright pixels will appear washed out. An image too high in mid-range pixels
will appear pale. Too many dark area pixels will result in a lack of detail. The StudioLine histogram
helps with assessing the effect of image tools to attain a well balanced picture.

The histogram can be switched to different views to match various image tools. “Red/Green/Blue” is
the default view, showing the distribution of brightness combined for all color channels. You can also
select one or multiple individual color channels, or view the distribution of saturation or color. In
addition, you can choose logarithmic or linear view and overlay the chart with a grid.

To illustrate the use of the histogram, let’s take a look at the “Auto Tone Levels” tool. Select a pale or
washed-out looking image lacking contrast. Open the “Auto Tone Levels” tool from the Image
Toolbox. In the histogram at the top of the Image Tools Bar the setting should already be the default
“Red/Green/Blue” – if not, click on the fourth circular button from the left, the grey one, next to the
individual color channel buttons and the black/white “Hue” button.

The image example above nicely illustrates the lack of pixels on the right in the graph. After clicking
on “Auto-Contrast” in the “Auto Tone Levels” panel, the histogram shows how the graph is now
spread across the entire brightness range.

The balanced brightness results in a much more vibrant image. You can further move the sliders in
the “Auto Tone Levels” panel and instantly observe the result in the histogram and on the image
itself.

Editing with Third-Party Applications

You can open images in your favorite image editing tool directly from the Image Archive. Right-click
on an image, choose “Original” from the context menu, and select the menu item “Open With”. You
will see a list of applications that Windows has associated with the file type of the original image.
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There will also be an option “Choose Program …” to manually pick a specific program. Use the option
“Edit Program Shortcuts” to define shortcuts to your own program choices.

In the panel “Create New Program Shortcut” enter a shortcut name. Then use the “Browse” button to
locate the appropriate program file. Accept your choices with the “OK” buttons and you will see your
new program shortcut appear in the context menu. You can manage any existing program shortcuts
in the panel “Edit Program Shortcuts”. Click the “New” button to create another program shortcut.
Once selected, your application will launch and you can edit the picture. When done simply save the
file and close it.

When launching third-party applications from StudioLine, you should be mindful of certain facts:

Any changes made with third-party applications cannot be reversed by StudioLine. If that is a
concern, make a copy of the picture before making any changes. Right-click the image and
choose “Create Duplicate” from the context menu.
Many programs offer a “Recent Files” list in the application’s “File” menu. Do not use the
“Recent Files” list or any other third-party technique to open StudioLine-managed pictures, as
StudioLine would not register any changes made. Instead, always open these pictures by
launching the application directly from the Image Archive.
Do not close StudioLine while you are editing a StudioLine-resident image with a third-party
application. If you closed StudioLine, then do not start it again until after you have completed
your work and exited the third-party application. If your changes did not carry over into
StudioLine after restarting, right-click the image, choose “Original” from the context menu and
select the “Refresh” function.
Any changes you have made to an image with StudioLine will not show up in the third-party
application. Since StudioLine does not actually change the source image, the effects of any
filters or tools applied by StudioLine will not be available to the third-party application.
Therefore, you should limit the use of third-party applications to those effects that cannot be
accomplished with StudioLine tools. Only StudioLine tool changes can be edited and reversed at
any time.
Once you have completed your work in the third-party application, choose the normal “Save”
option in the application’s “File” menu, or the closest equivalent. “Save” will simply replace the
image on the hard disk. Do not use “Save As” or “Save as Copy” or similar advanced functions,
because StudioLine would not know where to find the updated picture.

Making Changes to Your Images Permanent

When exporting images to standard graphics files, you have the choice of including the effects of all
tools and filters performed within StudioLine (see the section “Exporting” elsewhere in this manual).
Sometimes, it may be desirable to make changes to an image permanent even though it will stay in
the Image Archive. Do this by right-clicking on an image, choosing the submenu “Image with Image
Tools Applied” and select one of the available functions:

Open Copy With
This function is equivalent to the function “Original”, “Open With”, discussed previously in the
section “Editing with Third-Party Applications”. However, this time StudioLine will first create a
copy of the selected image and its descriptors, as well as permanently incorporate the effects of
all filters and tools, including any image preprocessing. The copy will have an empty “Active
Image Tools” list because all editing has been permanently fused into the copy. All descriptors
will, however, be carried over to the copy. This copy will then be opened in the third-party
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application.
Create Copy
Here StudioLine does the same thing as in the previous function “Open Copy With”, but does
not go on to open the copy in a third-party application. As above, the copy will have an empty
“Active Image Tools” list because all tools have been processed and directly rendered into the
copy. All the descriptors will nevertheless be retained.
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Image Pre-Processing

One of the key features of StudioLine is the ability to apply a complete set of image optimizations to
an entire series of similar pictures. For proper image alignments, to crop unwanted borders, or to
correct unappealing red pupil discolorations in people or animals (Red Eye Removal), use the
appropriate tool from the “Preprocessing“ section of the “Image Toolbox” panel.

Crop and Rotate

 If you simply need to change a photo from horizontal to vertical alignment (portrait vs. landscape)
or vice versa, click the “Rotate Clockwise” or “Rotate Counter-Clockwise” button on the bottom

toolbar. The Crop and Rotate selection in the Image Toolbox opens a window with more fine-tuning
capabilities. Align the dotted line of the crop tool to a line in the image and rotate to the exact degree
quickly and effortlessly. The “Crop and Rotate” tool performs a number of tasks:

Rotate
If your camera has no orientation sensor, then you will likely need to rotates portrait images by
90°.
Mirror
This can be helpful if a slide or transparency was scanned backwards.
Crop
Use the cropping knife handles in the panel to trim off any scanning margins or to define a
better composition.
Align
If the camera was tilted or an image was not perfectly aligned in the scanner, you can place the
alignment handles along a known vertical or horizontal line in the image.
Choose Aspect Ratio
Enter the desired aspect ratio and then select the “Fix” checkbox. Now the horizontal and
vertical cropping knife handles will always move together so that the resulting cut-out area will
maintain the chosen aspect ratio.

Red-Eye Correction

 An annoying result of flash photography is red pupil discoloration in people and other pupil colors
in animals. To correct this effect use the “Red Eye Removal” preprocessing tool.

In the left “Select Area” pane, click on a discolored eye. The “Select Red Eye” pane on the right
zooms into the selected area so that you can make an accurate selection. In the right pane, click
exactly inside the discolored pupil.

StudioLine will correct the discoloration. If the result is not satisfactory, you can manually adjust the
result:

The slider “Color Tolerance” expands or reduces the area that will be corrected, in case too much or
too little of the pupil was effected.
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The slider “Adjustment Effect” controls the intensity of the color correction.

Repeat these steps for as many eyes as necessary. Each corrected eye is tagged with a number. This
way you can later pick individual eyes and make further corrections. To remove the correction for a
particular eye, choose it with the “Eye No.” control and then click the “Delete” button next to it. To
remove all red-eye corrections, drag the “Copy” button of this panel to the recycle bin.

ICC Color Profiles

 ICC color profiles are based on a vendor-independent standard by the International Color
Consortium and define distinct color spaces for individual devices, such as monitors and printers.

This assures printed output will match the appearance on your monitor, assuming the devices support
ICC color profiles. To manage the ICC color profile associated with an image, select the image and
open the “ICC Color Profile” pre-processing tool from the image toolbox.

If there is already an associated color profile, it will be displayed. To assign a new color profile, open
the drop-down list and choose the color profile for the device that recorded the original image –
typically your digital camera or your scanner. (The drop-down list will only show color profiles for the
RGB color space).

When images are loaded that have new ICC color profiles, then those profiles are added automatically
to the “ICC Color Profile” list and can be used with other images.

You can set default color profiles to be associated with images that are loaded from specific sources.
Choose from the Menu Bar: “Preferences” → “Image Archive” → “ICC Color Profile”.

The “Cameras” list includes all models found in the Exif descriptors anywhere in the Image Archive.
From the “File Extension” list, choose a graphics file type used by the specific camera. From the “ICC
Color Profile” list, choose the default color profile to be associated with the selected camera/file
extension combination. You can use the “Add” button to import new ICC color profiles from disk or
other media. Click the “Apply” button to save the default color profile association.

Resize Original

 The size of digital images can be measured in two ways:

Pixel Size
Pixel size (for example 1024 x 768 pixels) defines the number of color dots that comprise the
image. A large number of pixels requires more storage space, but provides better resolution
since more detail was recorded. Images with a large pixel size are suitable for high quality and
large prints. An image with a small pixel size is good for emails and web sites, but nothing
more.
Print Size
The printed size of an image, measured in inches or cm, is a function of its pixel size and the
printer resolution (for example 300 DPI). A high resolution printer prints pixels closer together,
resulting in a smaller output. A lower resolution printer will print a larger print, since the number
of pixels remains the same, only the distance between them changes. Best results are
accomplished with an image that has a large pixel size printed on a high resolution printer.
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For maximum flexibility, StudioLine will catalog images without changing the pixel size. During export
or for sending emails, you can choose a pixel size to suit your needs (see chapters “Exporting” and
“Sending Images via Email”). When printing, you can choose a suitable print size (see chapter
“Printing – Custom Print”).

StudioLine does allow you to permanently reduce the pixel size of original images. This may be useful
if you scanned an original in better resolution than you ever expect to need. You should keep in mind,
however, that both print and internet technology keeps advancing with disk storage becoming
increasingly affordable. In a few years you could find yourself scrambling for that original size, which
may have seemed excessive today.

Preparing to Resize

Because resizing causes a loss of resolution, your final image will have superior quality if you first
perform all other pre-processing tasks. From the Image Toolbox, choose “Crop and Rotate” to define
the ideal cut-out area for your images. Choose “Red-Eye Removal” to correct any discolored pupils.
Also, any touch-ups you may want to do are easier to perform before resizing and will look more
convincing later. Only after these preliminary steps are complete, choose one or multiple images and
click on “Resize Original” in the Image Toolbox. StudioLine opens the “Resize Original” window.

Similar to the “Export” window, you can save and recall frequently used settings.

Image Size

The “Image Size” drop-down menu offers a variety of options, including common standard sizes. The
choice “Use Original Image Size” will retain the current size when using this window to convert
between graphics formats instead (for example from TIFF to JPEG).

“Custom” activates the width and height controls to define any custom size. The standard or custom
size you choose defines a bounding rectangle into which StudioLine will proportionally scale the
images. Consequently, one side of the resized image (unless it’s a square) will be smaller than the
chosen “Maximum Size”, if the selected width/height proportions do not match the image’s
proportions. Enlarging images produces poor image quality and is therefore not recommended.

The option “Automatically Adapt to Orientation” keeps your portrait orientation images portrait, and
your landscape orientation landscape. Let us say you specify an image size of 640×480 pixels, then a
portrait orientation image will be 640 pixels high, whereas a landscape orientation image will be 640
pixels wide. The long side will always receive the larger amount of pixels. This saves a lot of extra
steps and headaches.

Next to the image size input fields, you can choose the unit of measurement as pixels, inches, or
centimeters. That is helpful if images are later emailed to be printed at a given paper size. The field
“DPI” will let you control the print resolution.

Format

Near the bottom of the panel you select the file format. The default is “JPEG”, which uses a very
effective compression algorithm to reduce file size while retaining optimum image quality. JPEG
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format gives you the further option to customize image quality and file size as you need it. The higher
the quality, the more memory space the file will use. The lower the file size, the lower the image
quality, the quicker the image will load on a web page or in an email.

Other file formats have a static image quality, equivalent to the original quality. These formats have
high disk space requirements.
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Image Tools

Orientation and Size

Image Rotation

 Rotate the image to any desired angle by moving the slider or inputting the degree into the field.
Rotate in increments of 90 degrees, or mirror-flip, by clicking on the appropriate buttons.

Crop

 Utilize the cutting tools or the diagonal corner handles to define a new rectangular image border.
Check the option “Fix” to maintain proportional integrity. Hold down the Ctrl-key to move both

opposing cutting lines simultaneously. Click inside the cropping area – the cursor turns to a hand
symbol – and drag the area to be cropped without changing its dimensions.

Note: This tool only applies to a single image. Utilize the Advance Picture arrow buttons to move
among a previously selected batch of images.

Scale (Absolute)

 Adjusts an image to its maximum image size via pixel dimension input boxes. Checking off
“Maintain proportions” could result in one of the sides being smaller than the maximally possible

size. Turned off, this option may produce distorted images.

Is the original smaller than the desired maximum dimensions, no enlargement occurs to prevent poor
image quality. To override this safeguard, check off “Enlarging allowed.” Although StudioLine utilizes
a bicubic algorithm, loss in quality will be noticeable. You should always closely inspect the image to
determine whether the result is acceptable.

Scale (Percent)

 Adjust an image in relation to its maximum image size via percentage amount input boxes.
Checking off “Maintain proportions” could result in one of the sides being smaller than the

maximally possible size. Turned off, this option may produce distorted images.

Is the original smaller than the desired maximum dimensions, no enlargement occurs to prevent poor
image quality. To override this safeguard, check off “Enlarging allowed.” Although StudioLine utilizes
a bicubic algorithm, loss in quality will be noticeable. You should always closely inspect the image to
determine whether the result is acceptable.
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Correction

White Balance

 The highly intuitive white balance tool is ideally suited for adjusting color hues. It's as quick as it is
simple.

Click the “Pick-up Grey Point” button to turn the mouse pointer into a pipette. Click the pipette in an
area of the image that you know should be grey. StudioLine automatically corrects the color hue. If
necessary, use the options Gradation Curves, Auto-RGB, and Auto-Contrast, as well as the “Effect”
slider setting to perfect the results.

Gradation Curves

 The Gradation Curves Tool allows for an even more precise control of the luminescence of the
individual color separations, as well as the entire image. The gradation tool has a toolbar to control

the display, choose the color channels and manage points in the curve. Explore the various settings
and discover interesting image effects.

To get started, choose a color space from the toolbar, either “Tone Levels” or one of the color
channels. Initially, you can only control the end-points on the curve. Use the “Insert Point” button on
the toolbar to create additional handles that you can manipulate with the mouse.

Once you determine the perfect settings for a particular camera, you can save those by name.

Auto Tone Levels

 Increases image contrast by optimizing the tone levels for light and dark areas of an image and
utilizing gamma correction for medium range tones. This tool is helpful for images that are over or

under exposed as well as counteracting diffuse light problems caused by a large number of lenses.

Use the sliders “Highlights and “Shadows” to manually determine a reference point for the lightest
and darkest areas of the image. Checking off “Auto-Contrast” analyzes the image to automatically
determine the optimum setting.

Use the slider “Midtones” to manually determine a reference point for the midtone range of the
image. Checking off “Auto-Tone” analyzes the image to automatically determine the optimum setting.

The sliders can also be used to further refine the automatically determined settings after both Auto-
Contrast and Auto-Tone have been checked off.

Image Enhancement

 The three sliders for “Brightness”, “Contrast”, and “Saturation”, act like those found on color
television sets. The entire color spectrum is affected.
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Note: This filter changes colors linearly, which may lead to losses in the upper and lower color
ranges. Instead you may want to try the Exposure Correction tool which utilizes a more advanced
algorithm preventing this undesired effect.

Exposure Correction

 This tool offers three sliders. The “Brightness” slider targets changes of brightness in the middle
spectrum. The darkest and lightest colors receive the smallest change, which prevents the loss of

black or white areas in the image.

The “Contrast” slider allows fine-tuning of contrasts in the bright and dark areas of the image.

The “Saturation” slider utilizes a highly advanced algorithm that achieves much more balanced
results than the linear adjustments caused by the “Hue, Saturation, and Brightness” tool.

Hue, Saturation, Brightness

 The “Hue” slider of this tool window changes entire colors. If this tool is applied to only one target
color, it becomes possible to limit changes to specific color areas only. The effect of the color-

specific saturation slider is identical with that of the saturation settings of the color setting.

The “Brightness” slider keeps the hue and saturation constant, setting it apart from other brightness
tools.

Note: A small checkmark next to a color indicates that a setting is no longer in the neutral position.

Color Tuning

 This tool is a color equalizer effective on the saturation of a specific color that appears in the
image. It is especially useful to counteract discolorations due to original poor image quality or

scanning flaws.

Note: This tool is a sub-category of the “Hue, Saturation, and Brightness” tool.

Color Balance

 Selecting a specific color from the drop-down list and using the “Cyan-Red”, “Magenta-Green”,
and “Yellow-Blue” sliders you can correctly balance a specific color channel individually.

By selecting “All Colors” use the slider “Shadows-Highlights” for fine-tuning your color selection.

The three color sliders and the brightness slider limit the effect to the color of your choice.

Color
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 The “Color” tool is used for tinting or adding overall color to an image. It can be used to colorize
grey images for example. However, the correction of color problems in images is best done with the
tools “Color Tuning” or “Hue, Saturation, Brightness”.

Despeckle

 Small specks caused by dust on your scanner or on slides scanned can be removed easily with
this tool.

Sharpness

 This simple, one-slider tool increases sharpness of the entire image. It should be applied to an
image of final size; resizing undoes the effect.

Blur

 Like the sharpness tool, a simple, one-slider tool to blur the contours of your image creating an
out-of-focus look. Works well on backgrounds to create depth and to put the foreground subject

into greater clarity. It should be applied to an image of final size; resizing undoes the effect.

Unsharp Mask

 Using the sliders “Percent,” “Radius,” and “Threshold,“ as well as the option “Apply to Luminance
Only,” this sophisticated tool increases sharpness of the entire image. It should be applied to an

image of final size; resizing undoes the effect.

Gaussian Blur

 Utilizing the sliders “Percent” and “Radius,” this tool blurs an image by evaluating the color
values of all pixels in the image and shifting them towards the most common color in the image.

Selective Blur

 Similar to the Gaussian Blur tool, the Selective Blur tool had an additional slider “Threshold” to
further help you refine your effect by separating the image pixels into black or white extreme

values.

Effects
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Colorize

 This tool can be used to substitute specific colors of an image with other colors. The slider
“Intensity” defines the degree of colorization used in the image. If necessary, contrast will

automatically be reduced to retain the selected color.

Bicolor

 This tool applies a different color each to all dark and all light areas of an image. It is ideal to
retain the effect of an original duo-tone image. Sepia images are an example where this tool could

create a different bicolor effect, blue-green for example.

RGB Mixer

 This tool enables specific color corrections, creative color effects, and makes possible the creation
of high-quality black and white images.

Black and White

 This tool removes, on a sliding scale from 0-100%, the saturation of all colors. It differs from other
saturation tools because it corrects apparent differences in brightness; yellows become lighter

than blues.

Sepia

 Giving an image the popular sepia tint is easy with this tool. On a sliding scale it turns your image
from very light sepia to monochrome.

Scalable Backdrop

 This tool provides your image with a color background. By adjusting the background size to be
larger than the image the look of a frame is created. Adding rounded corners is also possible.

Soft Edge

 This tool softens the edges of a rectangular image by blurring them.

Text

 The Text Tool has a special ability. It can place text into the image from direct input as well as
from descriptor text. One classic usage would be a copyright notice – taken directly from the data
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base.

The upper section of the panel defines the text to be displayed. The default insert text is the system
descriptor “Copyright”. The descriptor name is always bracketed with paired percentage (%) signs to
look like this: %%descriptor%%. Descriptor values can be typed manually and bracketed so. You
can also click the “Insert” button and open the Insert Descriptor window which lets you conveniently
choose from a list of available descriptors. Of course, you will have to make certain that the
“Copyright” field or any other descriptor field actually contains text. Alternatively, you can simply
type over the default descriptor with regular text input. For multi-line text, type “\n” to force a line
break. Right-clicking in the Text field opens a contact menu via which you could alternatively access
the Insert Descriptor window as well as the option to insert special characters.

The middle section of the Text panel defines the font, style, shading, and shadow color. Using the
shadow effect is recommended for better readability when text is superimposed on an area with light
and dark background. The shadow color should be a strong contrast to the font color, for example use
a black shadow for a white text color or vice versa.

Font size remains constant for all picture sizes (thumbnail, zoomed, image viewer). The text will only
be scaled if it otherwise would not fit into the picture. To turn this feature off, uncheck the box “Scale
Text to Image Size”.

Further down you’ll find a slider. With it you can seamlessly adjust the transparency of your text in
the image. Making copyright text somewhat transparent on, let’s say an art photograph, causes less
visual disturbance, yet still remains readable. Large text or a logo sprawled across the entire image in
a watermark fashion discourages unauthorized “nabbing” of images from your web site, yet still
permits a view of the image itself.

The bottom section of the Text panel defines position and orientation. Clicking on one of the
positioning arrows correspondingly aligns your text in the image. Adjusting the direction of text to be
rotated up and down the left edge, for example, and setting edge distance can be done via the two
remaining controls.

Invert Image

 Using this tool’s slider converts your image into its negative opposite by exchanging the colors to
their RGB-complementary opposite and inverting brightness.

Note: This tool can only be effectively used on black and white negatives. Inverting color negatives
results in an orange cast.

Find Edges

 This tool finds the edges and outlines in your image and makes them increasingly more prominent
on a sliding scale of 0-100.

Transparency

 The Transparency tool adjusts the degree of opaqueness from fully see-through (the image is not
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visible at all) to fully visible (no transparency).

Note: A fully transparent image can be marked by dragging the marker frame on top of the
estimated position of the image in your workspace.

Invert Mask

 This tool inverts the transparency of an image. Opaque areas become transparent and previously
transparent areas become colored. This tool produces many interesting effects and is fun to

experiment with.

Smoked Glass

 The Smoked Glass tool is useful where a lot of text is to be superimposed on an image making it
easier to read. The tool gives a defined area in the image a colorization as well as reduced

transparency and added blurring, reminiscent of smoked glass.

Simple Backdrop

 A transparent or semi-transparent image can be given a colored background with this tool.

Emboss

 The Emboss tool adds a three-dimensional feel to your image that gives the illusion as if it had
been embossed.

Buttonize and Shadow

 Use this filter to create a 3-D effect to your image by adding light and shadow.

Choose the direction of the light source via the dial or the arrow buttons. Choose between “Drop
Shadow” or “Inner Shadow” shadow effects. Use the sliders “Density” and “Blurring” to adjust the
color depth and softness of the shadow.

Usually the button effect appears as a raised surface with a shadow below it, giving the appearance of
sticking out. With the option “Inner Shadow” the button appears sunk into the surface.

Note: This tool is not available in Image Archive mode, only in Page Editor mode.

Offset

 This tool enables the minute movement of an image’s position. Use it, for example, to slightly
offset a button in roll-over mode.
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Note: This tool is not available in Image Archive mode; it can only be used in Page Editor mode.
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Export Filter

These image tools will only take effect if you export an image. Here you can overlay a watermark to
your images e.g. with your logo or copyright information.

Watermark

To overlay your images with a watermark, select “Watermark” from the options in the “Export Objects
As…” window. This opens the Watermark window.

In the right “Layer” area, click on any layer you want to edit. From the toolbar on top of the list you
can add images or text to overlay, or you can remove the current selected layer. The current layer is
highlighted in the list and the element is displayed with a frame on the image preview.

In the bottom properties area you can modify each single layer.

Position
Nine points of reference are available to anchor an layer to the image. If the reference point
moves, any layer anchored to those reference points will move along with it.
Properties
Here you can set common properties like size, transpareny and rotation. For image layers the
size is given in percent to its original size, because the position and size of all layers will be
scaled according to the export output.
Presets
For images you can select an stored settings. By clicking on the settings button you can set up
colors, shadows and borders for the layer. For text layers you can enter any text including
placeholders like %%descriptor%%.

Predefine Settings

To build and save your own watermark settings you don't need to open the “Export Object As…”
window. You simply can open the “Watermark” image tool from the Image Tools menu.

The selection in the image archive is used as sample images for the preview area.

Once you saved the watermark settings while being in the image archive, you can load and use them
anytime you export images.
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Image Search

Not only can the StudioLine search engine be used to find a specific image, but it can also be used to
collect images from various folders which match a certain theme. The Image Archive “Search”
function collects all matching images in a temporary “Search Results” folder. Searches are based on
the content of image tags (“Descriptors”). By making extensive use of descriptors and entering
detailed descriptions, you will be rewarded with much more relevant search results.

You can quickly search for images just by entering words into the “Quick Search” edit field of the
Menu bar. After pressing the “Return” key, StudioLine starts to search for the requested image in the
currently opened Image Archive folder and all subfolders.

Advanced Search

To start the advanced search, click the “Search” button in the album view of the Image Archive Pane.

In the “Search Image Archive“ panel (see below), you can enter search criteria and also limit the
search to certain descriptors and folders.

By default, the entire Image Archive will be searched. Use the folder list on the right to restrict the
search to any folder. The “Search in” field will show which folder is currently selected, or “\” for the
entire Image Archive.

The drop-down list “Include Descriptors” allows you to specify which image tags are used to find the
search argument. From the drop-down list, select “Choose…” to open the “Choose Descriptors” panel.
For an even more targeted search, check the “Advanced Search” button in the “Search Image Archive
panel.

Here you can define complex search criteria, for example, locate all pictures that mention “Portugal,”
except those that mention “Lisbon”.

Time Spans

You can use the advanced search options “Date between” or “Time between” by clicking on their
respective boxes, and using the drop down menus to define the time span. You can then chose if your
images are to be found based on their File-, Exif-, or Modification date. Choose one of the three from
the dropdown menu “use descriptor”:

Search by Exif Date
This option includes images based on the creation date as recorded by the digital camera. You’ll
quickly find sunset photos from last year’s vacation.
Search by File Date
This option includes images based on the day that they were copied to your computer. This can
be helpful for scanned and other images that lack Exif information.
Search by Modification Date
This option includes images based on the date when they were last edited. This is an excellent
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way to locate images that you recently have been working on.

Search and Replace

The panel “Search Image Archive” is also used to perform a global change against the descriptors of
several images. This feature could be used to standardize spellings or abbreviations for certain
terminology, for instance.

Type the word or phrase to be replaced into the field “Search Argument”.
Click the “Replace” checkbox. Below, type the replacement text.

The replace is “case sensitive” – the search argument you typed must use the same combination of
upper and lowercase letters as the text you are trying to replace.

Managing Your Search Results

Matching images are arranged in a temporary Image Archive folder called “Search Results”. This
special purpose folder will be discarded as soon as a different folder is opened via the album view of
the Image Archive Pane. The found images can be viewed as a slide show, printed, emailed, exported,
or used in a web gallery. You can permanently save any such search collection of theme-related
images.

First, open the StudioLine Explorer “Image Archive“ and navigate to a target folder for your
images, or create a new one. (You could also rightclick on “Image Archive” in the album view of
the Image Archive Pane and choose “New Folder” from the context menu).
Click the “Select All” button on the toolbar, or press “Ctrl+A”, to select all images in the search
results.

For the next step you have several choices:

You may simply want to retain the search result for now so that you can process them at a
more convenient time. In this case, press and hold the “Alt” key while dragging the images from
the search results to the target folder. New shortcut objects are created in the target folder, but
all pictures remain at their original locations. This also guarantees that the shortcut objects will
always use the same descriptions, filters, image tools and settings as the reference images at
their original locations. Remember, if you ever delete any of the images in their original
locations, the shortcut object will be removed as well.
If you are trying to process the search result pictures with different descriptions, filters, or tool
settings, then press and hold the “Ctrl” key while dragging the images from the search results
to the target folder. Copies of all search result picture objects are created in the target folder.
Any work performed against the image copies will not affect the pictures at their original
locations. However, thanks to the underlying StudioLine database technology, no extra disk
space is required for duplicate physical images.
If you are trying to reorganize your pictures, drag the selected images from the search results
and drop them into their target folder. The pictures will be moved from their original location to
the target folder.



Last update: 2014/07/18 06:27 ebook http://help.studioline.net/ebook

http://help.studioline.net/ Printed on 2016/02/08 11:12

Image Archive Filter

The Image Archive Search function finds images from multiple folders and places them into a single
temporary Results folder. In contrast, the Image Archive Filter finds the searched images and displays
them in the folders in which they can be found, via a Results folder tree in the navigation pane.

Filter Criteria

To search using the filter function, select “Image Archive Filter” from the menu in the Quick Search
Bar.

The “Image Archive Filter” window will open. Choose the type of Descriptor you want to filter from the
dropdown menu. You can select any of the specific User, System, Exif, or other descriptors by clicking
on the root descriptor and then navigating to the specific descriptor.

Then choose the comparison operator. The dropdown menu allows you to scroll through
approximately ten choices. Finally, enter your unique value (word or set of words) for the search and
click “OK”. StudioLine will look through all descriptors for the search criteria and display the results as
a folder tree in the navigation pane.

You can use the button Show without folder tree at the top of the Image Archive Pane to show the
searched images contained in the folder tree without having to manually open the folders. (See:
“Viewing Folders with Subfolder Content” earlier in this manual.) If you click on the “Results” folder“,
you will see ALL of the images from your search in the Image Archive Pane to the right.

The folder tree shows an eye on it to indicate that you are in the Show without Folder Tree mode.
You can also click on the individual folders to just see the images from those folders. In this search,
different versions of the same image have been selected.

If you want a more targeted search, go back to your Filter Settings button. This will open your Image
Archive Filter window again, where you can combine multiple criteria for an advanced search.

Choose a Descriptor

Choose a comparison operator from the second drop-down list. For example the “contains”
comparison will look for a partial match. It will find images where the entered value can be found
anywhere in the chosen descriptor, even as part of a word. In contrast, the “equals” comparison will
look for images where descriptor content matches the entered value character for character with
identical lengths. Comparisons are not case sensitive – upper and lower case letters are treated the
same.

The third field has a dual function. You can either enter a search value or use the drop-down list to
choose from values that appear in the Image Archive for the chosen descriptor.

All three drop-down menus define the filter criteria. After selecting or entering press the “OK” button
for StudioLine to start filtering. The tree view in the Image Archive Pane will show only those folders
containing only the matching pictures.
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Combining Criteria

By combining multiple filter criteria, you can narrow or widen the search. Open the Image Archive
Filter and set up a first filter argument as discussed above using the descriptor, comparison, and
value field.

To widen the search, click the button “Include More Pictures.” To narrow the search, click the button
“Restrict the Search.” Pressing either button will display a new row to define an additional search
criteria A hit counter displays the number of matches so far. You will be able to define a total of 20
filter arguments.
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Deleting Images

To delete an image, either drag it to the Recycle Bin, located in the top right corner of the screen, or
press the “Delete” key on your keyboard. Your image will be deleted but not permanently so. Deleted
images are kept in the Recycle Bin. To view the content of the Recycle Bin, click the Recycle Bin, or
right-click and select “Open” from the context menu.

The window “Images in Recycle Bin” allows you to recover images using the “Restore” button. To
permanently remove all deleted images, click the button “Empty Recycle Bin” or right-click directly on
the Recycle Bin and select “Empty Recycle Bin” from the context menu.

When deleting an external image in StudioLine, you have the option whether you only want to delete
the information and settings of the image in the Image Archive or if you also want the actual
externally-stored graphics file to be deleted.

To safeguard against accidental deletion, images used in a web gallery cannot be placed in the
Recycle Bin. If you want to delete web gallery images, you must first delete the web gallery.
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Sending Images via Email

With StudioLine it’s easy to automatically create an email containing images you’ve selected. Select
any number of images, and select “Send Images via Email” from the “File” menu. Alternatively, you
can right-click on the selected images to open the context menu and select “Send Images via Email.”

The “Send Images via Email” window opens where you can determine the size and file format of your
image attachments.

The “Send Images via Email” window is, with the exception of a few logical differences, identical with
the already familiar “Exports Objects As...” window. Therefore the following explanations are mainly
refreshers.

Saved Settings

Here you can set and save frequently used email settings for easy recall.

Image Size

The “Image Size” drop-down menu offers a choice of standard screen and print sizes. The “Use
Original Size” option will email images in the size of the Image Archive originals. You can also use the
width and height controls to pick any custom size.

A standard or custom size you choose may not exactly fit the dimensions of the images to be emailed.
As in exporting, to safeguard against distortion or over-stretching, StudioLine will never enlarge
images beyond their original size or change their width/height proportions. Instead StudioLine uses
the “underfill” technique (discussed in the Exporting Images section). The size you choose defines a
bounding rectangle into which StudioLine will proportionally scale the images, as necessary.

The checkbox “Automatically Adjust for Orientation” will take the orientation of each image into
consideration and assign the larger specified size to the longer side of the image, and vice versa. If
you were to define a size of 640×480 pixels, then a landscape image would be exported 640 pixels
wide, while a portrait image would be 640 pixels high. Next to the two size control fields is a drop
down list with units of measurement: pixels, inches, or centimeter.

Images intended for printing or desktop publishing can thus be exported in the preferred unit of
measure. The field “DPI” will activate to let you control the print resolution.

File Format

StudioLine will propose to email images in the widely recognized JPEG format which cuts down file size
dramatically. The smaller the file size, the quicker your email will upload and send. The estimated size
of the email message appears near the bottom of the panel. Adjust the amount of compression by
adjusting the number in the field entitled “Image”. High quality (a higher number) is great for crisp
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online resolution and professional at-home printing. Low quality is really only suitable for images
where resolution is not important.

Other file formats will always use the quality of the original image. These file formats should only be
used for specific applications – such as sending images for professional quality print purposes. If you
need to send an image with transparent areas or irregular shapes, choose the TIFF or PNG file formats
and deselect the option “Colorize Transparent Areas”, as described below.

Other Options

Below the “Format” control is a list of additional options. Active options are displayed with a
checkmark. Click an option to activate or deactivate.

Apply Image Tools
If you deactivate this option, StudioLine will keep any pre-processing, but disregard other image
tools, filters, and effects that you may have used with this image. This allows you to email an
unedited version of your image.
Colorize Transparent Areas
By default, transparent areas (the “alpha channel”) will be preserved if the chosen file format
supports transparency (for example TIFF or PNG). Activate this option if you want the
transparent areas to be colored white instead. For graphics formats that don't support
transparency (for example JPEG, BMP), transparent areas will be always be colored white.
Omit Camera Specific Exif Data
StudioLine will include Exif, IPTC, and Windows tags with images if supported by the chosen
graphics file format. Select this option to omit any such camera specific information from the
emailed file.
Include Descriptors
This option will copy the system and user descriptors to the message body.

Preview

Click the “Preview” button to verify the result of your image settings before the files are sent. A
preview window will show the images based on all settings in the specified size and quality (for JPEG
images). Using the “Image Settings” drop-down menu, it's easy to find the ideal settings because the
preview will automatically refresh after any change. The toolbar allows you to browse between
images and choose a preview size A more detailed explanation of the window “Preview/Detail
Settings” is discussed in the chapter Exporting Images.

Sending

Click “OK” in the “Send Images via Email” window to send your email. If your email software is
compatible and has been defined as the default, it will automatically open and start a new message
with the selected images as attachments. Simply enter the recipient’s email address, type a message,
and send.
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Printing

Standard Print

StudioLine offers several different printing functions. The quickest way to put your images on paper is
the “Standard Print.” Select images to print, then click on the button “Print” of the Main Tool Bar. You
can also follow the Menu Bar path: “File” → “Print” → “Standard Print”.

On the left you can select one of the predefined print layouts with different image sizes and numbers
per page. Selecting a layout will update the page preview in the middle of the “Standard Print” pane.

Options

At the right of the window, you can choose one of the available printers and the number of prints per
image.

The option “Crop Images Automatically” will proportionally scale images to the chosen width and
height. If necessary, either the long or the high sides of the pictures are cropped to exactly fit the
chosen format. If the option is de-selected, then StudioLine underfills the images – the images will be
printed without cropping, but one side may be smaller than the chosen format.

When the option “Rotate Images Automatically” is checked, the images will be rotated to fit the
chosen format best. Otherwise the image will be cropped or scaled down (according to the option
“Crop Images Automatically”) to fit the chosen format.

Custom Print

Custom printing gives you complete control over all print options and offers a number of additional
functions not available in regular printing.

Print Spooler

Choose the following path from the Menu Bar path: “File” → “Print, Custom Print”.

The various images will appear listed in the “Print Spooler” panel the way they are lined up in queue
to be printed. Alternately you can open the Print Spooler directly by selecting “Print Spooler” as the
last choice in the above Menu Bar path. This way, drag images to be printed to the Print Spooler
panel. To print images or change their print settings, right-click selected images in the Print Spooler.
This will open a context menu with print and print settings functions.

The “Switch View” button on the top left in the panel toggles the image list between different display
styles. Control the print process in detail with the buttons to the right for number, size, layout of
images, and more.
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Number of Prints per Image

This button opens a panel to choose the number of times an individual image is printed. This can be
helpful, if various guests of an event ask for copies of different photos. Now that you have all desired
pictures in the Print Spooler select one or multiple images in the print queue, or use the keyboard
shortcut “Ctrl+A” to select all images. Click the “Number of Prints per Image” button and enter the
number of prints needed respectively. The advantage is that once you have defined the desired prints
for each image, you can start the entire print process and attend to other matters.

Print Settings

Click the Print Settings button to change the cutout area, orientation, size, or resolution of an image.

The drop-down list below the viewing area will list all popular image sizes. The cropping handles in the
image preview area will adjust automatically if the aspect ratio of the chosen picture format is
different than that of the picture itself. Any excess area is filled with a background color, which can be
chosen by clicking the “Background Color” button. If you do not want any excess area, crop the image
to a smaller cut-out area by dragging the cropping handles. Two perpendicular cropping handles will
always move proportionally to maintain the aspect ratio of the chosen picture format. To control the
cutout area, click in the center between the cropping handles. The cursor will change to a hand. Drag
the cutout in relation to the crop lines.

The option “Inverse Orientation” will swap height and width. This allows you to crop a portrait image
to landscape format, or vice versa.

Enter custom sizes in the two input fields below the size drop-down list. The cropping handles will
adjust to your input. Next to the size input fields you’ll find a drop-down list to change the unit of
measure between centimeters and inches.

Changing the image size via unit of measure or cut-out area will affect the print resolution, which is
displayed next to the unit of measurement. Print resolution is calculated as pixels per inch (ppi)
simply by dividing the pixel count of the image by the chosen physical image size. Please note that
small or severely cropped images could result in resolutions less than 100 pixels per inch, even if
StudioLine is optimizing the print output. In that case it would be best to choose a smaller image size.

If setting a specific resolution is your primary concern, then you can set a fixed print resolution
instead of choosing a size format. In the drop-down list for image sizes, choose the option “Fix
Resolution (DPI)”. A different set of options will appear below the viewing area:

The drop-down list for “DPI” automatically offers to use the image's native resolution. You can also
choose from a list of other common print resolutions or enter a custom DPI value.

Two input fields let you define the aspect ratio. The cropping handles will adjust to your input. If you
drag a single cropping handle, the aspect ratio will change accordingly. Choose the option “Fix Ratio”
to lock-in the current aspect ratio. Now, two perpendicular cropping handles will always move in
unison preserving the integrity of your chosen ratio. The option “Inverse Orientation” will swap height
and width. This allows you to crop a portrait image to landscape format, or vice versa. The resulting
print size is displayed next to the aspect ratio. “Resulting Size” is calculated in centimeters or inches,
simply by dividing the pixel count of the cropped image by the chosen DPI value.
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Any print settings that you implement on an individual image can be applied to all of your selected
images by pressing the copy button, this can save you valuable time. However, be sure to select the
images first, and then make the adjustments to the print settings.

Submitting Your Job to Print

After having set your options for each image, proceed by clicking the “Print” button. This will include
all images in the Print Spooler. To narrow down your print submission to specific images or groups of
images for printing, select them in the Print Spooler window before clicking the “Print” button.

The “Print” panel opens. Choose the printer you want to use from the dropdown list. The “Settings”
button will allow you to change options that are hardware-specific.

Two option buttons allow you to limit the print process either to specific images that were selected
from the Print Spooler – or to disregard the selection and print all images. The “Copies per Page”
option determines how often each page will be printed.

Use the helpful “Crop Marks” option if you intend to cut the printed images with the help of a ruler
and cropping blade.

To print captions below each picture, use the “Print descriptors below images” option. The panel
“Choose” opens. It operates like the “Descriptors” panel covered in the “Adding Descriptors” section,
earlier in this manual.

Click the “Print Preview” button to view the effect of any options you have chosen.

“Images per Page” can be used to limit the number of images that are printed on the same page. This
may be helpful when pages are intended for a photo album. The “Maximum Number” option will
minimize the use of expensive photo paper.

To maximally economize the use of paper, “Optimize Utilization” will change the order and orientation
of images across all pages, further keeping the number of printed pages to a minimum. This option
should be combined with the “Maximum Number” option if you plan to cut the individual images from
the printed page.

Use “Center on Page” to center the page content on the paper. It is useful for album pages since this
will produce the most aesthetically pleasing look and leave room for writing any notes around the
edges.

“Optimize Quality” will determine the exact resolution of the printer. If necessary, images are printed
slightly larger to best match the printer resolution. The results are higher-quality prints. However, the
printing process may be slowed down significantly. It may require some experimentation to determine
whether or not the slight improvements in quality warrant the increased time in printing.

Message "Image too Large"

Reason: The size of the image exceeds the size of the paper on which the image will be printed.

Click on “Scale the image automatically” to match the image size to the paper size.
Click on “Skip this image” to prevent the image from being printed.
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Whichever solution you choose, you can apply it to all of your images that are too large to be printed
by clicking the box Apply to All Images.

From:
http://help.studioline.net/ - StudioLine Help

Permanent link:
http://help.studioline.net/web/print_image

Last update: 2013/08/26 12:28

http://help.studioline.net/
http://help.studioline.net/web/print_image


Last update: 2014/07/18 06:27 ebook http://help.studioline.net/ebook

http://help.studioline.net/ Printed on 2016/02/08 11:12

Backup Originals to Disk

To safeguard your precious images and image editing work, you should back up your Image Archive
to CD, DVD or Harddisk on a regular basis. Conveniently, the backup function is built into StudioLine.

We recommend you store your backups at a secure location away from your computer and, if
possible, a different location altogether. This way you will be able to recover your images even in the
case of a catastrophic loss involving your premises.

Note: Web galleries are not included in the Image Archive backups. To safeguard your web galleries,
use the StudioLine Explorer “Pages” and export to “StudioLine File” format.

Backup to Disc

This function allows you to make copies of your original images to disc without losing the image
editing (effects, descriptors, etc.) which you achieved through StudioLine.

Backing Up

StudioLine collects the image originals stored inside the Image Archive (or depending on the settings,
they may be located on several discs) and copies them on to your computer’s hard drive. Descriptors,
key words, as well as tool effects are stored next to the originals in XML-data sets. The information
connected with each image in the Image Archive can thus be fully restored.

Restoration

How you restore images depends on your copy settings. Externally stored images are first copied
directly or in their folders along with their XML files to the place where you intend to save them
permanently; from there you drag them into the Image Archive. Internally stored images can be
directly dragged from the backup into the Image Archive.

Note: To be effective, the backup should always reside on a different physical drive than the originals
you work with, so that in case of a drive failure your backup does not get lost with the originals!

Backup to CD or DVD

The backup function can be performed for folders or the entire Image Archive StudioLine will copy the
original images together with any descriptors, tool and filter settings onto CD or DVD.

To backup a folder, right-click on the folder in the Albums view of the Image Archive Pane.
Choose “Backup” → “Backup Folder to CD/DVD” from the context menu. If applicable,
StudioLine will prompt you whether to backup any subfolders.
To backup the entire Image Archive right-click on “Image Archive,” the topmost listing in the
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Albums view of the Image Archive Pane. Choose “Backup” → “Backup Folder to CD/DVD” from
the context menu. When prompted whether to backup any subfolders, click “Yes”.

The window “Backup Folder to CD/DVD ” opens.

You can overwrite the default title that StudioLine proposes for the disc. If applicable, you can choose
which of your CD or DVD recorders to use, erase any re-writable media, and set the recording speed.

The lower part of the panel displays information about the current disc located in the burn drive, the
amount of data to be written, and the number of discs that will be required. Click “OK” to commence
the backup.

Once complete, StudioLine will suggest how you should label your disc(s). Since StudioLine will refer
to discs by its label, you should follow the suggestion and then store your backups in a safe location.

A backup disc can also be used to upload images to other computers that are running StudioLine. The
loaded images will include all descriptors, filters, tools, and settings. However, given the critical
importance of your backup disc, we recommended that you never let it out of your possession.

Backing Up New Pictures

StudioLine keeps track of any new images that are added to a folder after it is backed up. When you
select that folder for another backup, StudioLine will offer to perform either a full backup of all
images, or just an incremental backup of new images.

Restoring the Entire Image Archive

You can recover from a loss of your entire Image Archive (for example due to a hard drive failure) by
following these steps:

Reinstall StudioLine.
Start StudioLine and open “File” menu and choose “Restore from Backup”.
Follow the on-screen instructions.

Restoring Individual Images

To restore individual images, open the backup disc in “StudioLine Explorer – My Computer” (via the
“Browse and Load” button on the QuickStep Bar). Navigate to the backup images and drag them onto
the Image Archive desktop.

StudioLine will recognize if you try to restore an image that already exists in the Image Archive and
display the window “Image Already Exists in Image Archive”.

The two topmost fields display the name of the backup image and its location in the Image Archive.
For external images, you can view the location of the physical picture by resting the mouse pointer
over the second field.

A drop-down list offers choices on how to proceed with the image. For internal images, you can:
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Reload Original from Backup
StudioLine replaces the master copy in the Image Archive with the backed up image from the
backup disc. The option “Include Filters and Descriptors” will be off by default; changes made
after the backup will therefore be retained. If you choose the option “Include Filters and
Descriptors”, then the image, its descriptors, tools, filters, and settings are restored from the
backup – effectively reversing any changes made after the backup.
Keep in mind that the image will be restored to the original location illustrated in the second
field of the panel. If this is not the same folder you dragged the disc icon to originally, then
appropriate image shortcuts will be inserted into that folder.
Create as New Image
StudioLine creates a new image in the target folder you dragged the disc icon to. The option
“Include Filters and Descriptors” is always active by default. You will now have two copies of the
same image in your Image Archive.
Reload Original and Create Shortcut
This functions like the option “Replace the Original with the Backup”. However, StudioLine will
create a shortcut in the folder where you dragged the disc icon to, which refers to the restored
image at the original Image Archive location.
Skip
StudioLine will not restore the image. This is equivalent to clicking the “Cancel” button.

The option “Apply to All Backed Up Images” is only relevant, when you are restoring more than one
picture at a time and you want the same choice to be used for all other images that may already
exist. If you deselect this option, you will be prompted for each image individually.
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Exporting

Images that were optimized with StudioLine must be exported to be utilized in other applications such
as word processing or desktop publishing. StudioLine allows you to convert these images to all the
common image file formats and store them on your hard disk or other media.

Open the “StudioLine Explorer” → “Desktop” from the “File” menu. Navigate to the target folder you
intend to store the exported files in, or create a new one. Then, from the Image Archive desktop, drag
all the selected images to be exported into the right panel in the StudioLine Explorer window.

Alternatively, you can start by selecting images to be exported and then right-click to choose “Export
(Save As)” from the context menu.

In both instances, StudioLine opens the “Export Object as…” window. Here you can define details
such as the image size, file format and file name.

Exporting the Original

The option “Export Original” will export the unedited image in the original file format and size. In
addition a XMP sidecar file with the same file name is stored which contains all descriptors and image
tool settings for that image. You will have the choice to enter a different file name. Other settings like
file format and image size are not available.

Saved Settings

You may find that certain projects or certain clients demand specific file formats or sizes. To save
frequently-used settings for easy recall, choose the desired export options and then click on “Save
Settings” near the bottom of the panel.

You can choose an individual name for that particular set of settings.

Later, simply recall the same options from the “Saved Settings” drop-down list by selecting the name
that you assigned to that set of options.

Maximum Image Size

The “Maximum Image Size” drop-down menu offers a choice of standard sizes. The “Use Original
Size” option will export images in the size of the Image Archive originals. You can also use the option
“Custom” to manually set dimensions. A standard or custom size you choose may not exactly fit the
dimensions of the images to be exported. To safeguard against distortion or over-stretching,
StudioLine will never enlarge images beyond their original size or change their width/height
proportions. Instead StudioLine uses the “underfill” technique. The size you choose defines a
bounding rectangle into which StudioLine will proportionally scale the images, as necessary.
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The example below illustrates a custom size of 400 by 400 pixels into which a portrait or landscape
image is then scaled in such a way that its longest sides are 400 pixels:

The checkbox “Automatically Adjust for Orientation” will take the orientation of each image into
consideration and assign the larger specified size to the longer side of the image, and vice versa. If
you were to define a size of 640×480 pixels, then a landscape image would be exported 640 pixels
wide, while a portrait image would be 640 pixels high.

Next to the two manual size control fields is a drop down list with units of measurement: pixels,
inches, or centimeter. Images intended for printing or desktop publishing can thus be exported in the
preferred unit of measure. The field “DPI” will activate to let you control the print resolution.

Choice of file format is important for the intended application of the exported image. To use an image
on the Internet, the “JPEG” format with smaller image size is ideal. This format is supported by all web
browsers and uses a highly effective compression algorithm to reduce file size. You can further
individually set the level of compression using “Image Quality” control.

For print or archiving applications on the other hand, best results are achieved with a “loss-less” file
format, such as “TIFF” offers, in combination with a large image size for best resolution.

Other Options

Below the “Format” control you’ll find a list of additional options. Active options are displayed with a
checkmark. Click an option to activate or deactivate it.

Apply Image Tools
If you deactivate this option, StudioLine will keep any pre-processing, but disregard other image
tools, filters, and effects that you may have applied to this image. This allows you to export an
unedited version of your image.
Colorize Transparent Areas
By default, transparent areas (the “alpha channel”) will be exported if the chosen file format
supports transparency (for example TIFF or PNG). Activate this option if you want the
transparent areas to be colored white instead. For graphics formats that don't support
transparency (for example JPEG, BMP), transparent areas will always be exported as white color.
Omit Camera Specific Exif Data
StudioLine will export images with Exif, IPTC, and Windows tags if supported by the chosen
graphics file format. However, certain Exif information would disclose make and model of the
camera, as well as camera settings in effect while an image was taken. If the file format allows
it, select this option to omit any such camera-specific information from the exported file.

Preview/Detail Settings

Click the “Preview / Detail Settings” button to verify the result of your export settings before the files
are actually exported. The preview window will show the image based on all settings and filters, in the
specified size, and, for JPEG images, compression quality as well. It is here that you can set
compression quality and use the sharpen tool. It's easy to find the ideal settings because the preview
will automatically refresh after any change. The toolbar allows you to zoom and choose a preview
size. There’s also an “Adjust Window” button that automatically adjusts the window for preview size
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and aspect ratio.

Images for Web Use:
For web images an important goal is to minimize file size. Choose the JPEG file format and with
the “Image Quality” settings you'll be able to find an optimal compromise between quality and
size.
Images for Print Use:
For images in JPEG format destined to create prints or to be cropped in other applications, set
the preview size to “Scale up to 100%”. Watch the preview window while you experiment with
the “Image Quality” settings until you find the lowest value that does not impact quality.

Path to Export Location

If you launched the export by dragging images to their intended location in “StudioLine Explorer – My
Computer”, then the export path will already be set. Otherwise, or if you want to change the export
location, in the “Export Objects As…” window, click the “Browse” button below the path and navigate
to the folder of your choice. Click the down-arrow in the path field to recall the most recently used 5
export locations from a drop-down list.

File Naming Conventions

By default, StudioLine will use the “Image Name” descriptor value as the export file name. When
exporting more than one image, it is represented by an asterisk. Upon export, StudioLine will
automatically append a sequence number to the name in the new location if multiple images have
been selected bearing the same name. You can simply write over the name if you prefer a different
one. The input field “File Name” has a down-arrow to open a drop-down list offering different options
for automatic file name schemes:

* (Asterisk)
This option, as just discussed, only appears if more than one image is selected for export. It
represents the “Image Name” descriptor value. Choosing this option will use the image names
as file names. If multiple images have the same name, a sequence number will be appended for
uniqueness.
{Number}
This option represents a number corresponding to the order of images in the Image Archive.
You can thus sort images in the Image Archive and export them with filenames that preserve
that order. One application might be a picture CD or DVD that will play images in the intended
sequence on TV. You can add text before or after the “{number}” placeholder in the “File
Name” input field to create more descriptive file names such as: “Vacation {number}” or
“{number} Burgundy”.
{Descriptor}
With this option, the file name is based on the content of an image descriptor. Choosing this
option opens the “Insert Descriptor” panel where you can view and select suitable descriptors.

Additionally, a combination of numbers and descriptors is also possible.

To preview the resulting file name, hover the mouse over the “Path” input field. A tool-tip will show
the export file name for the first image.
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Click “OK” to initiate the actual export process.

CD/DVD Burning

Save - Put your best quick shots on CD/DVD for maximum safety. Should it be necessary, StudioLine
inquires whether the subfolders should be saved as well.

Offload Folders to CD/DVD - After a while, it may not be necessary for you to have regular access
to images in certain folders, the function 'Offload Folders' allows you to move the large original copies
of all the images in a folder onto a CD or DVD. When the offloading is successful, the files on the disk
are deleted, thereby saving valuable space.

Export Folder to CD/DVD - Writes the images of a current folder into the most useful file format
onto a CD or DVD.

Note: Clicking on “close window” will stop the burn process.
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Create Web Sites

StudioLine makes it easy to work with websites of any size. If your website consists of only a small
number of pages and files, then the need for advanced planning is minimized. As your site grows, you
can subsequently add an organizational scheme.

Nevertheless, advance planning is advised if you expect to build a robust website with up to
thousands of web pages which might contain images, media objects, and folders. Using StudioLine,
the web designer can easily manage large projects or an extensive list of clients' sites by organizing
all related files into folders.

Choice in Naming Conventions

Creating names for sites, pages, images, and folders is easy with StudioLine. Names can be created
irrespective of character set limitations. Thus, it is a snap to search and find a folder, page, or image.
Nevertheless, logical title choice and correct spelling will enhance your search results.

When a page is first published by StudioLine, correct and permanent external names are generated
for the web server since character set limitations exist outside of StudioLine. The external name is not
usually visible to the user, but nevertheless closely resembles the initial internal name.

The advantages of separating internal and external names becomes apparent as the site grows
and/or the structure of the site changes. With StudioLine Explorer, a web master can rename objects
or organize them in folders without restriction, even after the site has already been published.
External names and web addresses (URLs) are completely unaffected by reorganization. Maintaining
search engine positioning and keeping visitors' bookmarks valid are two additional, extremely
valuable features.

Organizing with Folders

Sites

Most users maintain a small number of sites, and therefore will not require site folders. However,
StudioLine can help you seamlessly maintain your clients intranet-, staging- , and internet production
sites, by creating one folder that encompasses all related sites.

Layout Templates

If you are maintaining more than one site, each with multiple layout templates, it is a good idea to
organize your custom templates in folders per client and/or per site.
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Pages

Grouping related pages into folders will help un-clutter a large site or allow you to make use of
automated folder links.

Image Archive

Image Archive folders may be created to represent clients, sites, subject areas, applications, or even
periods of time. The best organization for you will depend on the type of images you collect over time.
StudioLine offers an extremely effective search engine to locate images across all folders. Carefully
chosen descriptions of your images utilizing logical keywords will pay off, especially once your site has
grown to a respectable size. Folders for individual object types are entirely separate. You may choose
to use folders for one type of object and not for another.

Publishing Profile

The Publishing Profile lists the server information for each website making it easy to go back and forth
between different sites and the required information.

Sectioning a Large Web Site

Large web sites are often maintained by a team of web masters. Distinct sections, such as Products
and Services, Customer Support, Corporate Public Relations may have different requirements or
employ a specific look and feel. In StudioLine, one can treat each web site section as a unique site. In
this way, each site can be based on different layout defaults and be maintained on different
workstations.

Creating a Site

To create a new web site choose from the Menu Bar: “File” → “Site” → “New.” Next, choose a
standard layout. By clicking on the list, an example of the layout is shown to the right. Then, click on
the button “continue”.

A new window will open which will allow you to type in the name of your site. As an example, you
could choose “Kingfisher”. Click “ok”.

The StudioLine Explorer automatically opens showing you a list of all the pages associated with your
template. You can click on each page to edit them and add images or you can navigate the different
pages via the left-hand navigation pane.

Should you prefer to create new names for the individual pages of the template site, you can easily
change them in the left-hand navigation page. A window will open that prompts you confirm if you
want the URL to match the new page name.
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Publishing Considerations

Once a site is completed, it must be published to the respective subfolder on the web server. This is
accomplished by specifying the appropriate “Remote Directory” in the publishing profile of a site.

Enter the name of your FTP server, login information, as well as the web address (URL) of your web
server. You should be able to get these pieces of information from your web hosting provider. Using
the StudioLine Explorer-Sites window, you can view the publishing profiles of each site.

Implications when Linking

When sites are kept on a single workstation, then it is simple to create links between pages by using
simple drag and drop. If multiple workstations are used to maintain distinct sections of a large site,
then web designers have to manually enter appropriate URLs to link between pages contained in
different StudioLine sites.
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Site Settings

There are two ways to access the settings. You can be in the Page Editor mode, and right-click on the
site you want to work on and in the context menu select Settings. Alternatively, you can open Site
under the File menu, and a context menu will be visible. Click on Site Settings and the following
window will open up.

Name - The site name is used only within StudioLine and doesn't have any relationship to the
published website.

Folder - Indicates where the website is stored within StudioLine.

Home Page - By browsing through your site, you can choose which page you would like to be treated
as the homepage of your site. This will be the first page a browser goes to when users visit. If you
uncheck the Home Page box, the home page currently on the server will be deleted. However it
remains saved in your StudioLine files. Nevertheless, all existing navigation links that relate to the
home page will become inactive.

Default Layout Template - Choose the layout template that should be used for every new page that
will be created within this site.

Publishing Profile - Choose the publishing profile that should be utilized for the transfer of this site
to a server.

Use International Character Set - If this is activated, you can place letters and symbols from other
languages that do not use the Latin alphabet, for example, the Greek or Russian alphabets. The pages
can then be generated in Unicode character set (UTF-8 encoding).

Attention: This parameter can result in rendering the characters into unreadable symbols or
international characters by the server. If you would like to use international characters, you will also
need to have alternative keyboard layouts defined and the keyboard needs to be switched into that
mode. Be aware that you will need to choose a font that supports the desired character set. The Font
Format window only displays supported formats.

The following keyboards are currently recognized:

Designation LCID(Local ID) Character Set
EL Greek 1032 161
RU Russian 1049 204
BG Bulgarian 1026 204
UK Ukrainian 1058 204
MK Macedonian 1071 204
SR Serbian 3098 204
CS Czech 1029 238
HU Hungarian 1038 238
PL Polish 1045 238
RO Rumanian 1048 238
ET Estonian 1061 186
LV Latvian 1062 186
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Designation LCID(Local ID) Character Set
LT Lithuanian 1063 186
TR Turkish 1055 162
Other —— 0
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Links

When a website visitor clicks on a link, the browser changes to another page or executes an action. A
supplemental feature of StudioLine provides a series of generated links (for example, Home or Next
Page). The actual address of such links are automatically created by StudioLine once the project is
published.

To create a link, select your object and go to Link under the Edit menu, or right-click on the selected
object and go to Link in the context menu. A window will open which will allow you to choose what
type of link you want to create, and to initiate those links.

Link Types

Link to Page or Project

Creates a link to another StudioLine page.

Use the Browse button to find the desired project or page. Then click 'ok'. Use the button Create Page
for Link if the desired page hasn't been created yet. A new page will be created with the desired link
embedded. If the page is taken offline, the link will be treated as if 'No Link' had been chosen.

Link to URL

Creates a link to an outside page, other project or to other resources.

Example URLs

Web Site: http://www.StudioLine.net/
FTP Site: ftp://ftp.hm-software.com/
Newsgroup: news://News.HM-Software.com/HM.Public.Support

Note: StudioLine does not verify or monitor the validity of external links. To ensure a seamless
experiences, the web master should regularly monitor whether the links are remain valid.

Link to Email

This Link will open the email application of the visitor. Be sure to provide a valid email address and a
subject.

Navigation link

These generated links are intended for pages in subfolders or for layouts that use Image Views.

As you can see, this window provides multiple options for navigation between pages and Image
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Views, allowing the user to spring from various points to other points and levels within the web page.

Not every Navigation object is utilized by every page. The unused objects become inactive and can be
generated partially transparent.

Link to Image View/Dynamic Image View

These generated links are used for Layouts with Image Views. Detailed and automatically created
Image View of this object are linked.

Link to Target Position

Creates a link to a predefined position or to a qualified object in a StudioLine page. The browser is
prompted to open the page and to scroll to a specific place or object within a larger page of content.
Place the Drop button onto an object of the target position. This establishes the page and target
position.

Use the Page button to browse for the page to which you would like to establish a link.

Use the Target Position button to determine where on the page you want the target position to be. A
drop down menu provides choices. Alternatively, you get to the Target Position in the context menu
once you have selected an object on a page. The following window will open up and automatically
name your targeted object.

Link to Local File

Choose a file on your hard drive that will be published on the server under a specified URL. This
option is for non-standard file formats, that will be downloaded by webpage visitors or that will require
a browser plugin.

Link to Digital Map

Allows you to link to a digital map. First the object or image must contain geotagging or location data
so that it can send the browser to the digital map. You will not be able to verify the link until the page
goes live.

Action Link

This function can be used to specify browser actions including print a page, or close the browser, or to
go forward or back.

Link to Image in Image Archive

This link allows one to place a link directly onto a selected image from the Image Archive.
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No Link

Removes every link.

Open New Browser Window

Normally pages are opened in the same browser window. By clicking the box and specifying in the
Options window, you can dictate the parameters of the how the image is displayed in the new
window. By leaving the name field empty, the linked page will always open in a new window.

If you reuse the same link name as for other links, these will all be displayed in the same window. The
effects of the advanced options can be different from browser to browser. For example, Internet
Explorer embeds the window borders, title list and other navigation elements together.

Verifying URL and Email links

This feature reviews links for validity and correctness and enables general changes on all existing
links in a project. Open the Verify Links tab under the Publish menu. The upper pane displays the list
of URLs and email addresses embedded in the current web page with status indicators in front of
them.

Valid links are displayed with a green check.
Links that still need to be checked are displayed with a gray question mark.
Invalid links are displayed with a warning sign. To view the actual error message, roll the mouse
over the warning sign.

You can click on an individual link in the pane and then press Selection or you can simply have them
all verified by choosing All. If you decide to change or delete a link, click on the Change Link button
and the following window will open up. Here you can enter in the new URL or leave the field empty to
delete the link.

Once the page has been published, you can also right-click on the link and go to the Follow Link tab
to verify it.
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Pull-Down or Dynamic Menus

Using pull-down menus you can create large menu structures in a clear and space saving way. You
website will look less cluttered, menu paths will be easier to recognize, and the interactivity is fun to
use. Website pull-down menus act like the ones we already know from computer programs.

Without yet moving your mouse over any menu items, the initial menu points showing are main menu
items like “Products”, or “Exhibits”. Once a visitor to the site triggers such a main menu item with a
cursor movement, a further sub-menu folds down, similar to a new window opening, showing further
submenu items. Once the cursor is moved away from the sub-menu list, it folds away again. Pull-down
menus can have many layers.

Creating Pull-Down Menus

In Page Editor mode, follow the Menu Bar path: “Edit” → “Dynamic Menu” → “Edit Dynamic Menu”.
Check off the box “Create new dynamic menu” and enter a name for the new menu in the field below
it. Click “OK” and a window entitled “Dynamic Menu” opens. Here you can begin to create and edit
further items and other settings.

It is also possible to create a copy of an already existing menu. This is helpful if you already like a
certain menu structure, its font, color, etc., and want to use it again with different text. You can select
the name of the existing menu from the list in the Edit Dynamic Menu window. Make sure to activate
the option “Create as copy from selected menu”.

These dynamic menus are not bound to a specific project. If, for example, you manage different
sections of a website from different projects, you could easily apply the individual dynamic menus
over and over again.

Deleting Menus

Open the window “Edit Dynamic Menu” and select the menu you would like to delete, then click on
the red X “Delete Dynamic Menu” button. A prompt will ask you to confirm. This will affect all pages
that use this menu.

Editing Menus

After opening the “Edit Dynamic Menu” window you can see the structure and entries of an existing
menu in a list. You can add new entries, move, or delete them. Further options are available by right-
clicking on the respective menu entry.

Below the menu structure you can set the links for the individual menu entries. Select a menu item
and a activate one of the link type buttons in the lower half of the window. “Link to Page” opens a
window “Browse for Page” from which you can select a target page. “Link to URL” places a cursor into
the field below it, enabling you to type in a URL address.
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The “Open New Browser Window” option causes the link to open the target web page in a new and
separate window while leaving the source web page open in its own unchanged window. This is
helpful when you do not want the site visitor to navigate away from the page of the activated link.
Uses for this could be copyright information or explanatory text, or a detail view of something. The
visitor could easily close that window when done viewing it and readily continue perusing the original
web page waiting in its original window.

Next to the tab “Menu Structure and Entries” you will find the tab “Settings”. Here you can set the
appearance of the menu.

Border settings include outer and inner border width, color, and optional shadow. Shadow intensity
and shadow color can also be assigned.

Font settings determine the type of font used in the labeling of the menu items. Also set horizontal
and vertical margins to determine distance of text from borders, as well as both regular text color and
Color in Focus Mode.

Clicking “OK” saves your settings. When working on several menus use the “Browse” button to
navigate to the different menu choices. Edited menus will automatically be published the next time
you publish the page.

Assigning a Dynamic Menu to an Object

In Page Editor mode, dynamic menus can be assigned to any images or text objects. When a visitor to
your site moves the cursor over the assigned object, the menu will appear. Moving the cursor away
from the objects causes the menu to disappear again.

To assign a dynamic menu to an image or text object select it and follow the menu path: “Edit” →
“Dynamic Menu” → “Apply Dynamic Menu”. In the “Apply Dynamic Menu” window you can select the
menu that will appear when a user’s cursor moves across the object. Use the “Edit Menu” button to
open the “Dynamic Menu” window and set or change settings. The dynamic menu will appear left-
justified underneath the assigned object. You can change the distance from the object to make it
appear at a different position, using the controls in the “Offset to Object” area.

Removing a Dynamic Menu from an Object

You can remove a menu from an assigned object simply by dragging the “Copy Settings” button to
the Recycle Bin.
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Design Elements

Graphical elements, such as colored shapes or lines, help perfect your layout. You can import these
elements into StudioLine like any other images. Since StudioLine has a large collection of such
elements already available for you, for many applications finding and importing them won't even be
necessary.

Right-click on the page background. From the context menu choose “Insert”, then “New Design
Element”.

The newly created design element can be moved like any image. The sizing handles can be used to
resize, stretch, and shrink the design element to suit your needs. For pixel-perfect sizing, right-click
on the design element and choose “Size” from the context menu.

Further display options are controlled by choosing “Design Element Properties” from the design
element's context menu. This window provides a range of interesting possibilities to add decorative
touches to your page.

Background and Color

Select the “Transparent” option to create empty frames. To create a frame with a solid color
background, or one where the color fills the frame gradually from transparent to solid, either with one
or two colors, from top to bottom, side to side, or radially, click the appropriate button. You can also
choose to use a background image instead of a color fill.

Lines and Corners

Use the “Lines and Corners” controls to determine for each of the four sides, whether your design
element will have a border, its color and thickness. Use the “corner” controls to create square or
rounded corners. For rounded corners, you can define the radius. (You can define rounded corners
even if your design element doesn't have any borders.)

Top and Bottom Color Bands

You can fill the top and/or bottom portion of the design elements with a color of your choice.
Additional effects for the design object can be accomplished with the help of the image toolbox.

Size

Grab the anchor points on a selected design element and adjust as necessary. To maintain the ratio of
the object, adjust it by the corner anchor points. To alter the ratio of the object, adjust it from the
sides or top/bottom anchor points.
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Custom HTML Code

You may insert your own HTML code, server scripts, and support files into StudioLine's rendered HTML
code.

Include HTML File

Some of your HTML code may not be represented visually, such as function definitions, global
variables, and some of the server scripting. Sometimes, the code may be extensive, is shared
between many pages or you simply prefer to maintain that code outside of StudioLine. In that case,
use Include HTML Files to augment the code that StudioLine renders.

Create a basic HTML document outside of StudioLine, with HTML, HEAD, and BODY tags.
Insert your custom code at the proper locations in your document.
Choose Include HTML File via the Page menu in the Menu Bar.
If necessary, choose URL from the Page menu if the rendered page needs to be uploaded under
a specific name or file type.

During publishing, the content of your Include HTML File will be merged into the appropriate locations
of the rendered page. If you make changes to your included HTML file, you need to manually select
the StudioLine page for publishing.

HTML Object

Where feasible, it may be easier to maintain your custom code directly from within StudioLine. This
also allows you to upload external files into StudioLine. Choose Insert HTML Object from the File
menu.

In the HTML Object Properties, choose the location on the page for your HTML code. Typically, code
placed in the HEAD or BODY section is not represented visually. Code placed in a DIV section will be
processed at the position of the HTML object on the page.

If you require an additional support or media file, use the Browse button to include it. StudioLine will
publish the file to the /Media folder on your site. Type or paste your HTML code into the HTML Code
Editor. For HTML objects with visual content, drag the object to the proper location on the page and
use the sizing handles to reserve space.
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Web Galleries

Web galleries are photo albums that you can share with anyone over the Internet or on CD/DVD.
StudioLine generates your web pages complete with navigation links, which can be viewed with all
popular web browsers, then publishes them to the server indicated in your web publishing profile.

Each web gallery you create is structured around an index page showing thumbnail images of all
pictures in that gallery. Clicking a thumbnail image will open a larger view of that same image,
together with any narrative text you may like. Again, the automatic application of descriptors comes
in very handy here. Navigation buttons make browsing to other images in the gallery or returning to
the index page easy.

Creating a Web Gallery

In Image Archive select any number of images, then click the “Create Web Gallery” in the File Menu.

Choose one of the styles listed in the left pane and click on it to preview the gallery’s sample index
page in the right pane. Further information about the selected style is given in the pane at the bottom
of the window.

The hint panel indicates the maximum number of images that can fit on the index page for the
selected style. If necessary, StudioLine will create additional index pages and add the necessary
navigation links between them. The hint panel also identifies which descriptors will be used to display
informational text with each image (see chapter “Working with Images: Adding Descriptions”). Select
your design choice by clicking the “Continue” button.

Web Gallery Settings

This window opens up as the second of four steps during the creation of your Web Gallery. In this
window you can specify various details of your Web Gallery. Note that each Predefined Web Gallery
Style may have different settings. Thus, the style you have chosen may or may not have the exact
options indicated below. However, most of them share a majority of basic features which are
described below. This window is from the Predefined Style 'Modern/Black with Popup and Text'. It is
best to play around with the styles to get a feel for what they can do.

Page Title/Text
This will be the header for your web gallery. It will be displayed at the top of your page of
thumbnails. If you would like a subtitle, be sure to click the indicated box. Enter any other text
and subtext as allowed by this particular gallery style. The text can be revised in a text editor
once gallery has been completed.
URL of the Index Page
This any desired URL which your Web Gallery will provide a link to; e.g. your own web site.
Email address (optional)
Enter an email address if you would like visitors to have a means of contacting you. It is not a
required field for the web gallery.
Generate Link to Map View if Gallery has Geotags



2016/02/08 11:12 113/122 StudioLine Web Designer 4 - English

StudioLine Help - http://help.studioline.net/

If you have location based information attached to images, you can create automatic map links
by clicking on this option.
Enable Rollover Effects for Thumbnails
Click on this box if you want to allow rollover effects for your thumbnails. In this particular
Predefined style, a rollover includes a full size image popup.
Images per Page
Indicates the maximum number of images allowed per page for that Predefined Gallery style. If
you exceed the maximum number of images, StudioLine will create more than one index page.
Detail Views/Size of Image View Pages
You have a choice between the size of the enlarged view page, either 640×480 or 1024×768.
Detail Views/Copyright text
Here you can input the copyright for the images that will get displayed.

A line at the top of the window shows where your gallery is being saved. You can click on the
navigation pane to the left to change the subfolder where it is being placed, or you can create a new
subfolder by clicking on the folder icon at the upper right. Type in the name of your new gallery.

After clicking the final “Continue” button, there will be a slight delay while StudioLine generates the
web gallery. Your new web gallery is now saved as a page in a site. StudioLine will then switch to
Page Editor mode to display the result and, if your “Hints” are turned on, you will be given choices on
how to proceed.

You can now work on your gallery pages. Change font, background, margin, etc. by clicking on text or
right-clicking on the background and selecting from the context menu. Refer to the QuickStep Bar for
additional instructions.

Return to the Image Archive via “Photo” in the Main Tool Bar.
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Editing Web Galleries

Once you open an automatically generated web gallery, you’ll notice that some text blocks such as
headlines contain placeholder text. To replace placeholder text with your own, double-click on the
placeholder text. This opens the Text Editor tool for the text block. Type over the placeholder text,
then double-click on the next text you want to edit to open the Text Editor on that text block. Close
the Text Editor by clicking anywhere on the background of the Page Editor workspace.

Return to the Image Archive via “Photo” on the Main Tool Bar.
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Changing and Updating Web Galleries

After editing any images that were used in a web gallery, or after changing the descriptors, you may
want to update the web gallery to reflect your changes. Some web gallery styles also permit you to
revise some of the text passages. In any case, StudioLine will have to re-render the web gallery pages
and transfer a new version to the web server.

Opening an Existing Gallery

Click on “Web” on the Main Tool Bar to open the most recently used web gallery. You may also click
“StudioLine Explorer – Pages” in the “File” menu. This will open an Explorer panel showing all
available web galleries. Rightclick on a web gallery icon and select “Open Page”.

Renaming a Web Gallery

To rename a web gallery, navigate to it in the Navigation pane, ensure that you have clicked on 'Sites'
at the bottom of the Navigation pane to be in the correct mode. Then right-click on the name and
choose Rename. The name field becomes active and you can type in the new name.

StudioLine will ask you if you want to replace the URL of the web gallery with the new name.
Depending on your preferences, click 'yes' or 'no'.

Deleting a Web Gallery

Navigate to the web gallery in the Navigation panel, ensuring you are in the Sites mode. Right-click
and choose “Delete” from the context menu. You can also drag the gallery to the recycle bin.
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Previewing Pages

To preview and test a page or web gallery to see how it will appear in a web browser, select “Render”
from the “Publish” Main Toolbar Bar icon.

StudioLine will generate the necessary HTML documents. This process may take a few moments
depending on the number and size of images. A message box will advise you when the page has been
rendered. Choose “…browse a preview of the rendered page(s)” to open the page in your computer’s
default web browser.

Verify that the appearance of the pages meets your expectations and test the links from the index
page, as well as the navigation between the individual image view pages. If necessary, close the
browser and make adjustments in the StudioLine Page Editor. For another preview, click “Preview”
once again. StudioLine will reopen the browser once the updated page has been rendered.
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Transferring Web Sites

To view your web gallery on the Internet, it needs to be published from your computer to a public web
server. Sometimes, your Internet Service Provider (ISP) provides free web space as part of your
monthly access charges. Otherwise, you will have to arrange web space (usually for a modest fee on
a per annum basis) with one of the many web-hosting providers available today. Doing an internet
search will bring up the available choices for your area.

Registered StudioLine users receive free web space to test the web gallery features for a limited time
on the StudioLine servers. By utilizing the StudioLine servers to transfer and upload your Web Gallery,
you can be assured that all of your web gallery objects get safely transferred.

StudioLine uses the universally supported “FTP” (File Transfer Protocol) for uploading your files to the
web server. It is strongly recommend that you let StudioLine perform the uploading. StudioLine has
built-in validation to confirm that all new or updated components of your web gallery are uploaded
successfully.

Click “Transfer” from the “Publish” Main Tool Bar icon.

Publishing Profile

The “Edit Profile” panel opens – either as an empty form or with information you previously entered.
The information in the publishing profile enables StudioLine to contact the web server and transfer
your gallery. StudioLine uses the same publishing profile for all of your web galleries.

Constructing your Publishing Profile

The information to fill out the publishing profile is obtained from the provider of your web space.
Usually, you’ll only need to fill in the fields FTP Server, Login/User, Password, and the “Root URL”. The
remaining fields can remain at their default values. If your provider does not specify a separate FTP
server, then it may be the domain name of your web site (for example “www.YourDomain.com”) and
the URL of the web site root would be “http://www.YourDomain.com”.

To upload your pages to specific folders on your FTP server, specify the “Remote Directory”. If the FTP
folder translates to a corresponding folder on your web space, then append the folder name to the
URL of the web site following a forward slash, for example a remote directory of “MyFolder” would be
represented in the URL as “http://www.YourDomain.com/MyFolder”. The name of the “Default
Document” is server-specific, usually “default.htm”, “index.htm”, or “index.html” and can be obtained
from your web-hosting provider. StudioLine requires this name to generate proper names for your
pages. If you are unable to obtain the name, StudioLine will attempt to determine that name for you
while testing the publishing profile (see below).

The number of “Maximum Concurrent Connections” tells StudioLine, how many parallel FTP sessions it
may open in an attempt to maximize bandwidth and reduce total upload times (possibly reducing
your connection fees.) Some providers do not permit more than one connection. StudioLine will
attempt to determine the maximum number while testing the publishing profile.
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Sometimes workstations are running behind firewalls or have personal firewall software installed to
avoid intrusions by unauthorized parties. Depending on the firewall technology and configuration, it
may be necessary to specify a “Proxy Server”, a “Port”, or to select the option “Passive”. Your local
system administrator will be able to assist you with the correct configuration.

After filling in the profile, click the “Test” button. StudioLine will connect to your web server to test
and verify your settings and make any corrections as needed. If the test fails and StudioLine cannot
determine the correct settings, then an error message will indicate the specific circumstances.

It is possible that your web server requires less common settings for “Remote Directory”, “Root URL”,
and “Default Document”, which differ from the above examples. In that case, you will need to contact
your web-hosting provider for the correct information.

Image Rendering Preferences

Through this window, the default image quality is determined. This is used for images that are placed
into a Page or a Layout.

A setting of 80 or higher prevents the over-compression of the color resolution. The is especially
important for Text objects that are being generated as a graphic. Moreover, as mentioned previously
in this manual, StudioLine recommends that you import most text as a graphic in order to avoid
variations of font from program to program.

You access this window through the 'Image Rendering' tab under the 'Preferences' menu.

Image Quality - That is the settings/properties of an image. The button 'default value' returns the
quality setting at 80.

Text- Graphic Quality - This is the setting for every text object that is generated as a graphic. The
button 'default value' returns the quality setting back to 90.

Image Quality

The size of an image effects the time required to upload a web page and available disk space.
Therefore, web designers spend a great deal of time in an effort to reach a good compromise between
image quality and the upload time of a web site page. StudioLine was developed with the goal of
automating and optimizing this process.

You access this window by choosing 'Image Quality' in the 'Edit' menu.

Original Size - Examine the original image and review its size in its original, totally uncompromised
form.

Compressed Size - Assess the quality of the compressed image and review the compression-based
size.

Navigation - Page through your images with the help of the navigation objects (should more than
one image be marked).
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Quality - Assess the JPEG compression- factor. Images of higher quality load slower, whereas images
of a less good quality can appear less appealing.

You have the ability to adjust your upload preferences in the 'Image Rendering' tab under the
'Preferences' menu.
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Exporting Web Sites

Sites, layout templates, pages and images may be shared between users or copied between
StudioLine sites. This allows work to be delegated between multiple users and the ability to reuse
designs for more than one project. StudioLine can also exchange text and images with third-party
word processing software and graphics tools.

This process is similar to the one documented in the section “Export as StudioLine File.” From the
Menu Bar item choose “File” → “Export” → “StudioLine File”.

In the Panel “Choose Objects to Export” click on “Pages”. To export all web pages click “OK” without
selecting a specific page. To export individual pages select one or multiple web pages in the right
pane. Remember that you can select multiple non-consecutive pages by holding down the “Ctrl” key
while clicking.

Sites

Choose Export or Import from the File menu to transfer an entire site, including publishing profiles,
layout templates, pages and any associated images or media files. When either importing or
exporting the StudioLine Explorer - My computer window will open up to facilitate the transfer of files
or sites.

Layout Templates

Choose Export or Import from the File menu to transfer layout templates and associated images,
media files and dynamic menus between computers. StudioLine Explorer - My computer will open up
so that you can locate the file.

Double click on the layout and the program will prompt you to rename the new template in the
desired folder. You can see where it is being saved both by the highlighted name of the site, and also
in the menu bar. Should you want to change the location of the file to be saved, simply navigate to a
different site, and rename the new layout there.

Pages

Choose Export or Import from the File menu to transfer a page, its layout and any associated images,
media files or dynamic menus.

Effects and Collages

The power of StudioLine's image tools can also benefit other applications. Open the StudioLine page
editor, compose a collage of images, and apply any desired effects. With collage still selected, right-
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click on the mouse to see the context menu, and choose 'Export As'. A new window will open up that
will allow to choose whether to export the collage as individual files, or as a single entity. From this
window you can determine what other variables, for instance any associated Image Views, you would
like when exporting your collage.

Format - Choose the desired file format for your export. A drop down menu gives you many choices.

Quality - Choose an image quality number that suits your needs regarding final file size and image
quality.

Rollover Pictures - If you have rollovers on your collage, you have the option to export both the
rollover pictures and normal mode of the image. Choose this option to export both versions of each
image.

With Transparency - choose this option of your collage includes transparency information (Alpha-
Canal) that you would also like to be exported.

Path - Choose a path where you would like your collage to go. Press the Browse button to select the
existing folder or path. The selected path is then shown in the path field.

Image Name - choose a name for your newly exported collage or separated images to assist you
finding them at their new location. In the event that multiple images are exported, StudioLine inserts
a series of names. If you begin the name with “*”, StudioLine knows to create a file name that is
derived from each image.

Text

Text blocks may be dragged directly from most word processing tools to the StudioLine page editor.
In cases where this may not work, create a new text object on the page, then copy and paste the text.

Text can be exported as a graphic or as a text file. To do this, select the text, and then right-click to
get the context menu. Select “export (save as)”. The following window will open up where you can
specify the format.

Text Effects

The StudioLine page editor and its image tools offer great opportunities to design interesting
headlines or banner text. Once image tools are applied against a text element, it can be treated as if
it were an image and exported for use by other applications.

Design the banner text.
Open the StudioLine Explorer for My Computer and choose a destination folder.
Drag the text element to the destination folder.
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